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1 Information about this manual

1.1 Symbols and means of representation used

Safety notices are used in this manual to warn of the risk of personal injury or property damage.

  Always read and observe these safety notices.

  Observe all notices that are flagged with a safety alert symbol and signal word.

The following symbols are used in this instruction manual:

Symbol Meaning

 DANGER Hazardous situation.

Failure to observe this notice will lead to death or serious injury.

 WARNING Hazardous situation.

Failure to observe this notice may lead to death or serious injury.

 CAUTION Hazardous situation.

Failure to observe this notice may lead to minor injury.

NOTICE Information on the avoidance of property damage.

INFO Information relating to the understanding or optimization of working practices.
 One-step instruction
1. ...

2. ...

3. ...

Multi-step instruction

 Carry out the steps in the order shown.

ü Requirement

Necessary or labor-saving steps for the successful execution of an action

1.2 Scope

This instruction manual applies to all HO-EL pincers with the ELK 02 V2.x control unit.
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1.3 New features

1.3.1 The ELK 02 V1.X 

Hardware

• Hardware compatible with ELK 01

The hardware and CAL 01 connectors are identical to the ELK 01. Therefore the ELK 01 hardware can be used with 

the ELK 02.

• Power supply range 85 - 265 V, 47 - 63 Hz

• USB interface, type B, galvanically isolated

• X20 interface, extended inputs and outputs

• Bus options, e.g. PROFINET / PROFIBUS 

• X3 RS232 interface, galvanically isolated

• Graphic display unit, 65x35 mm, with 4 control buttons, display-driven for ease of use

Software

INFO
ELK 01 software and data sets cannot be migrated to the ELK 02.

• All pincer types are stored in the ELK 02 

• Storage capacity for 99 active program numbers (APNs)

• Nominal force input directly on the ELK 02 (without PC)

• Closure with detection to prevent double closures

• Force and gap priority with verification for the qualification

• Measurement screen can be called directly from the individual closure data view

• Compressed air input pressure monitoring, static and dynamic

• Function key “i”: displays the compressed air input pressure and the pincer type

• Software updates for ELK 02 online via PC

• PC backup function, data and settings

• PC restore function, data and settings

• Pincer test in 3 different modes

• Pincer test documentation

• New password structure

• Maintenance instructions
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1.3.2 The ELK 02 V2.X

• 4 user keys on the graphical display can be disabled (switched off).

 The ELK 02 then behaves like an ELK 01.

• Dual closure: improved gap priority closure

• Improved gap priority closure

• OK pulse output at the interface X2 in the pincer test

• Alphanumeric text field in the measurement screen

• Individual closure data simplified;

  Because of the implementation of DUAL closure and for better overview and easier operation, the individual 

closure data viewing screen has been revised:

 In the closure functions there remain only

 - Force priority

 - Gap priority

 - Dual closure

  Verification is switched on and off via a þ (e.g. þ Open, þ Hold etc.).

  The closure function and verification are determined by the pincer type.

  Even after pincer type, closure function and verification have been selected, the individual closure data view 

screen still permits changes.

  The data contents are compatible with earlier firmware issues.
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1.4 Abbreviations

APN  Active program number (max. 99)

D  Closure function code for dual closure

d  Closure function code for dual closure with 

verification

DS  Detection gap

DK  Detection force

F  Closure function code for force priority

f  Closure function code for force priority with 

verification

HK  Holding force

HK-T  Holding force tolerance

HS  Holding gap

HS-T  Holding gap tolerance 

HS-SK  Closing time between holding gap – closing 

force

HS-SS  Closing time between holding gap – closing gap

KK  Contact force

KS  Contact gap

NO  Not ok (refers to “Not ok” closure)

OF  Open

OF-SK  Closing time between opening – closing force

OF-SS  Closing time between opening - closing gap

OF-Z  Removal time

OS  Opening gap 

OS-SK  Closing time between opening gap – closing 

force

OS-SS  Closing time between opening gap – closing 

gap

OS-T  Opening gap tolerance

pE  Compressed air supply pressure

pA  Compressed air output to pincer

S  Closure function code for gap priority

s  Closure function code for gap priority with 

verification

SK  Closing force 

SK-HZ  Closing force holding time

SK-T  Closing force tolerance 

SS  Closing gap 

SS-HZ  Closing gap holding time

SS-T  Closing gap tolerance

UK  Changeover force from force priority to gap 

priority

VK  Verification force

VK-HZ  Verification force holding time

VK-T  Verification force tolerance

VW  Verification value

VW-T  Verification value tolerance

ZT  Pincer test  
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1.5 Labels on the ELK 02

Fig. 1 Labels on the ELK 02

1 Warning labels (on the back of the control unit)

2 Warning label

3 Risk of crushing 

4 Rating plate
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2 Basic safety instructions

2.1 Using the instruction manual

•  Make sure that this instruction manual is always kept close at hand ready for use.

•  Pass on this instruction manual to the next owner.

•  Please read through the instruction manual carefully before operating the ELK 02 unit. Familiarize yourself 

with all settings and their functions. Anyone involved in setting up, commissioning, maintaining or repairing 

the unit must have read and understood the instruction manual and in particular the safety instructions.

2.2 Use for the intended purpose

The unit may only be used for the intended purpose and under technically safe and fault-free conditions.

The ELK 02 and associated OETIKER pincers are intended solely for the controlled closure of OETIKER clamps and 

Low Profile Clamps. 

Use for the intended purpose also covers observance of this instruction manual and compliance with the technical 

data.

Any use not in accordance with the intended purpose is regarded as incorrect.

Use other than for the intended purpose

The ELK 02 has been developed in accordance with the best available technology and is safe for use. Residual 

dangers remain if it is used incorrectly or by untrained personnel. The operator of the ELK 02, not the manufacturer, 

shall be held responsible for any personal injury or property damage arising from incorrect usage.

2.3 General safety instructions

•  Observe all operating and maintenance instructions.

•  Maintenance and repair work should always be carried out by qualified specialists.

•  The ELK 02 unit may only be used by people who are familiar with its use and have been informed of the 

risks.

•  All relevant accident prevention regulations and other generally recognized health and safety rules must 

be complied with. The manufacturer shall not be held liable for damage resulting from unauthorized 

modifications to the ELK 02.
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Spare parts

In order to ensure the fast and accurate delivery of spare parts, a clear purchase order is essential. It must include 

the following information: 

• Product name, software version

• Type designation

• Serial number

• Name of spare part and number of units required

• Spare part number

• Shipping method

• Full address

Details can be found in the OETIKER tools catalog.

Improvements to the machine

In our endeavor to continuously improve the quality of our products, we reserve the right to make improvements 

without changing the instruction manual. Details of dimensions, weights, materials, performance ratings and names 

may therefore be subject to necessary changes. Regarding electrical diagrams, the diagram supplied with the 

machine takes precedence in all cases.

2.4 Special safety instructions

Only specially trained personnel are authorized to carry out maintenance and repair work on pneumatic equipment. 

  Depressurize the machine’s pneumatic equipment before starting maintenance or repair work. 

  Check hoses for wear as part of the preventive maintenance routine and replace them if necessary.

2.5 Safe working practices

  Before each start of production, check the ELK 02 for visible damage and only use it if it is in perfect 

working order. 

  Any defects must be reported to a supervisor immediately.

 Do not continue to use the ELK 02 if defects have been identified.

2.6 Modifications, changes

•  No design or safety modifications may be made to the ELK 02 without our express authorization. We 

shall not be held liable for damage resulting from any modifications. In particular, repairs of any kind are 

prohibited.

•  The securing screws on the control unit and the ELK 02 pincer are sealed with lacquer. If the lacquer is 

damaged, OETIKER cannot accept any claims under warranty. 

•  Use only original spare parts and accessories.

•  Do not dismantle any safety equipment.
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2.7 Qualified personnel

Only authorized and qualified personnel are permitted to use this machine, subject to compliance with the technical 

data and the following safety rules and regulations. Qualified personnel are people who are familiar with setting up, 

assembling, commissioning and operating the product and who have the qualifications appropriate to their job role.

2.8 Maintenance work

The inspection and maintenance intervals specified in the instruction manual must be complied with. Maintenance 

and repair instructions must be followed accordingly.
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3 Design of the ELK 02 system

The ELK 02 electronically controlled pneumatic pincer system comprises the following main components:

Fig. 2 Design of the ELK 02 system

1 Status lamp *)

2 Pre-filter 

3 Accumulator

4 Control unit

5 Pneumatic pincer EL

6 PC with installed software

7 Closing force sensor SKS 01 *)

8 Calibrator CAL 01 *)

*) optional extra
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3.1 Optional extras

 A number of additional items are available for the automation process, including 

•  Test equipment CAL 01, comprising the calibrator CAL 01 and closing force sensor SKS 01, for measuring 

the pincer jaw force (closing force) and for calibrating the ELK 02

•  Status lamp X2L01 for the visual detection of OK and NO closures and for the audible detection of NO 

closures

3.2 Design of the HO EL pincers

Fig. 3 HO EL pincers

1 Rotary adapter

2  EL trigger unit (“optional” extended trigger not 

shown) 

3 Possible mounting surfaces

4 Pincer plate

5 Pincer jaw

6 Grease nipple

7 Union nut

8 Lock nut

9 Pincer body

10 Vent holes

11 START button

12 LED light

13 Suspension loop

NOTICE
Risk of pincer jaw damage

  When using the HO 10000 pincer model, make sure that the compressed air supply pressure pE does not 

exceed 5 bar.

NOTICE
The vent holes (Fig. 3/10) must not be blocked.
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3.3 Connections on the ELK 02 control unit

INFO
For details of the inputs and outputs on the control unit please refer to section 13.1, from p. 13-116.

Fig. 4 Control unit, connections

Item in Fig. 4 Name of interface Type/use
1 pA Compressed air output to pincer

2 X1
9-pin SUB-MIN-D (male)

Pincer connection
3 X2 15-pin SUB-MIN-D (HD) (male) Inputs/outputs

4 X3

9-pin SUB-MIN-D (female)

• Computer connection RS232

• Connection CAL 01 RS232
5 X20 25-pin SUB-MIN-D (male) Inputs/outputs
6 X5/6/7 Option
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Item in Fig. 4 Name of interface Type/use
7 USB USB interface
8 Optional bus interface
9 Optional bus interface
10 Vent
11 Vent
12 3-pin IEC connector (male)
13 On/Off switch
14 pE Compressed air supply pressure (see safety notice below)

Table 1 Connections to the control unit

NOTICE
Risk of pincer jaw damage

  When using the HO 10000 pincer model, make sure that the compressed air supply pressure pE does not 

exceed 5 bar
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4 Process description

The ELK 02 is used for closing OETIKER clamps and Low Profile Clamps under the following conditions:

• quantified

• qualified

• verified 

Quantification

Corresponds to the definition of gap and closure values.

Qualification

Corresponds to the definition of tolerances for gap and closure values and monitoring time profiles during closure.

Verification

Closure of the pincer jaws at the verification force VK, a reduced force for determining the verification value VW.

Detection

Detection identifies a second closure on the same clamp or Low Profile Clamp and reports it as NO.

All physical values necessary for the function can be input via the PC using the ELK 02 software. The PC can then 

be used if required for recording the closure data and for inputting the nominal force.

Contact detection

The contact detection function determines the contact position of the corresponding clamp with the material being 

clamped at the start of compression.

4.1 Closing force

OETIKER clamps and Low Profile Clamps must be closed with a recommended and uniform closing force 

(force priority). This results in a consistent, reproducible and permitted tensile load on the strip material, without 

overloading the individual components, the parts being clamped and the clamps. 

The recommended closing forces for each OETIKER product group are listed in the technical data sheets. 

The closing force can be altered by changing the parameters in the ELK 02 control unit.

It is critical to use the clamping force established for both the clamp and the specific application.

The closing force test device (i.e. test equipment CAL 01) is used for determining and setting the closing force.
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4.2 Procedure

1.  Insert the ear of an OETIKER clamp (Fig. 5/1) into 

the clamping area on the pincer head (Fig. 5/2).

For OETIKER Low Profile Clamps:

2.  Position the pincer jaws on the tensioning hooks 

of the Low Profile Clamp.

2. Press the START button (Fig. 6/3).

Closure is initiated and the ear (Fig. 7/4) of the clamp is 

closed.

In the case of Low Profile Clamps, initiating closure 

reduces the clamp diameter to the required size for 

engagement. Depending on the product, the clamp is 

either engaged automatically or by applying contact 

pressure on reaching the engagement position.

On reaching the predefined parameter values the jaws on the pincer head are opened.

INFO
The closure sequence is dependent on the closure data and on the predefined system data. It is initiated by 

pressing the START button, for example.

A further closure operation can be performed. 

If special heads are used – e.g. for closing OETIKER Low Profile Clamps – the details will differ from those shown in 

the diagrams in Fig. 5 to Fig. 7.

Fig. 5 Insert clamp

Fig. 6 Start closure

Fig. 7 The ear is closed
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4.3 Sequence of operations

The sequence of operations when working with the ELK 02 system is divided into two sections:

• Test level

• The closure level

4.3.1 Test level

Fig. 8 The test level

ELK 02 einschalten

System-Test 
Regelungseinheit und Peripherie

bei erreich. Schließungen
(gem. System-Einstellung)

Zangentest-Aufforderung 
extern (gem. System Einst.)

über V24 (X3) 
CAL 01 / PC

keine Autorisierung notwendig FUNKTION 
Zangentest APN

Autorisierung

Zangentest

Fehlermeldung 
F1...F4, F15

Fehlerbehebung

Fehler Quittierung 
(gem. System-Einstellung)

Überspringen

Schließ-Ebene
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NOTICE
In order to ensure uniform and reproducible process quality it is mandatory to perform an assembly tool pincer 

test at least once per shift, minimum daily. Furthermore, a pincer test is mandatory in the event any pincer 

components are replaced.

To maintain consistent pincer force, sufficient compressed air pressure and volume must be provided.

After pincer test, Oetiker recommends verifying the closing force as a secondary validation.

It is essential to ensure clamp closures are not conducted in pincer test mode.
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4.3.2 The closure level

Fig. 9 The closure level

Kraft-/Weg-Prior oder Dual

mit oder ohne Halten, 
detektieren, Kontakt 
detektieren, mit/ohne 

verifizieren

Start

extern

Vorwahl APN extern

NO

Fehlermeldungen 
während der Schließung 

F1...F24

Datenprotokoll
Messergebnisse
Fehlermeldungen

chaotisch

Taste Zange

OK

singulär sequenziell
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5 Assembling and connecting the ELK 02

5.1 Connecting the control unit

INFO
When assembling and connecting the ELK 02 system, please observe the following points:

•  To ensure an adequate circulation of air, there must be a gap of 10 mm between the control unit (Fig. 10/8) 

and the wall (Fig. 10/7).

• Do not alter the length of the corrugated hose (Fig. 10/3) (length 3 m, optionally 6 m or 12 m).

  When the pincer (Fig. 10/2) is not in use, store it in a (plastic) holder (Fig. 10/1), for example.

  Make sure that the bending radius of the corrugated hose (Fig. 10/3) is not less than 50 mm when in use.

  Warning: Compressed air must be clean and dry, free of oil and moisture.

Fig. 10 Connecting the ELK 02

1  Holder for pincer (plastic recommended, 

supplied by others)

2 Pincer

3 Corrugated hose

4 Strain relief

5  Ferrite ring for interference suppression

6  Connections to the control unit

7  Distance from the wall to the control unit 

(10 mm)

8  Control unit

9 Compressed air connection

10 Compressed air line

11 Compressed air filter
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1. Mount the control unit (Fig. 10/8) so that the display is clearly visible to the user.

2. Connect the corrugated hose (Fig. 10/3) to the pincer (Fig. 10/2) with a strain relief device (Fig. 10/4)

 (clip, item no. 13600035 or mounting plate, item no. 13600028).

3. Connect the corrugated hose (Fig. 10/3) to the control unit (Fig. 10/8).

4. Connect the PC etc. to the control unit (Fig. 10/6).

5.2 Compressed air and pneumatic pincer

5.2.1 General information and requirements

NOTICE
Damage to the pincer

  Never clamp the pneumatic pincer at the cylindrical part of the pincer body (Fig. 3/9, p. 3-15) other than in 

the case of model HO 7000 at the reinforced point in the middle of the pincer body.

  Never drop or strike the pneumatic pincer.

  Never lift the pneumatic pincer by the corrugated hose.

INFO
To optimize the closure of OETIKER clamps and Low Profile Clamps, we recommend using a floating mount for 

OETIKER EL (T) pincers that are mounted in a jig. Appropriate devices are available as an option.

• The compressed air supply pressure must be between 4 and 10 bar; 6 bar is recommended.

• For the HO 10000 this must not exceed 5 bar

• A cutout mechanism with prior venting must be provided for the compressed air supply.

5.2.2 Connecting the compressed air

1.  Compressed air pre-filter (Fig. 10/11) (item no. 05005930), suspended as shown in a suitable location by 

means of the mounting bracket supplied.

2.  Connect the compressed air pre-filter to the compressed air supply inside the building (1/4" thread).

3.  Connect the compressed air supply line (Fig. 10/10) to the compressed air connection (Fig. 10/9) on the 

control unit (Fig. 10/8) and to the compressed air filter (Fig. 10/11) (external diameter 8 mm, internal diameter 

6 mm, suitable for pressure up to 10 bar).
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5.3 Aligning the pincer head

The pincer head (Fig. 11/3) can be rotated into a convenient position for the user.

 WARNING
Risk of crushing from the pneumatic pincer

Fingers can be crushed when the START button (Fig. 6/3) is pressed or when a start is initiated by an external 

control.

  Do not hold the pneumatic pincer in the clamping area.

1.  Switch off the ELK 02 control unit.

2.  Shut off the compressed air supply.

3.  Loosen the lock nut (Fig. 11/1).

4.  Loosen the union nut (Fig. 11/2) slightly.

5.  Rotate the pincer head (Fig. 11/3) into the desired 

position.

6.  Tighten the union nut (Fig. 11/2) and secure with 

the lock nut (Fig. 11/1).

7.  Execute a pincer test.

Fig. 11 Aligning the pincer head
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6 Working with the ELK 02

ü Requirements:

– The ELK 02 must be connected (see section 5, p. 5-23).

– The PC program must be installed (see section 7.2, p. 7-28).

– A compressed air supply must be available (see section 5.2.2, p. 5-24).

6.1 General instructions for handling

NOTICE
If the vent holes on the ELK 02 are closed the ELK 02 will not work properly and an error message is output.

  During operation, the vent holes (Fig. 12/2) on the pincer body (Fig. 12/1) must not be blocked.

  Make sure that any fixture that is fitted does not block the vent holes.

Fig. 12 Vent holes

6.2 Switching on the ELK 02

1.  Switch on the ELK 02 using the On/Off switch 

(Fig. 13/2) on the control unit (Fig. 13/1).

After switching on, a system check is performed. If all 

the checks are OK, FUNCTION appears in the display.

2.  Perform a pincer test  (see section 8.3, p. 8-40).

3.  Select the closure function you require (see 

section 9.4, p. 9-84).

If a fault occurs on switching on (see section 14.3, 

p. 13-130).

Fig. 13 Switching on the ELK 02
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7 Menu navigation in the PC program

7.1 System requirements and installation

• Computer:  Pentium 4 processor or equivalent – CPU 500 MHz or higher

• Graphics:    Screen resolution min. 1024 x 764 pixels

    recommended 1280 x 1024 pixels or higher

• Memory:   512 MB RAM, 100 MB free disk space

• Operating system:  Windows XP®, Windows Vista® or Windows 7®

Installation notes

The program must be installed and started up for the first time by somebody with adequate user rights. If an error 

message appears during installation or on initial startup, please contact your system administrator.

ELK 02 can be installed in parallel with an existing ELK 01/ELS 01 program.

The program CDs (or USB stick) are full program versions and contain the following:

• PC software

• Process data (pincer-related data)

• System settings

• Clamping data (default force and gap data)

• USB driver; Installation see section 7.2.3, p. 7-29

• Languages file

Rights necessary for installation

The following rights in particular are necessary for installation and initial startup:

• Creation of a new folder and subfolders in which the software is to be installed.

Subsequent running of the program requires the following rights:

• Full access to the program folder and subfolders in which the software was installed (by default):

 “C:\oetiker\elk02”.
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7.2 Installing the PC program

INFO
The following descriptions assume a basic knowledge of the Windows operating system.

7.2.1 Installing the program automatically

1. Close all open applications.

2. Place the CD in the CD-ROM drive. 

 After a few seconds the installation instructions will be displayed on the screen.

Fig. 14 Start menu

3. Follow the instructions on the screen.
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7.2.2 Installing the program manually

If the CD-ROM drive does not support automatic installation, the program can be installed manually.

1. In the Windows taskbar click START.

2. In the Start menu select the menu command “Run...”.

3. Input the following in the input box:[drive]:\Intsetup.

 drive = name of CD-ROM drive, e.g. D:\Intsetup

4. Click OK.

5. Follow the instructions on the screen.

7.2.3 Installing the USB driver

INFO
The USB driver does not install automatically.

1. Start installation by double clicking on the .exe file in the “USB-Driver” on the installation CD.

2. Select 32-bit or 64-bit according to the computer configuration.

Windows 7

If an old USB driver is already installed on a Windows-7 computer this can continue to be used.

Windows 8

To use the new USB drivers under Windows 8, any driver previously installed must first be uninstalled.
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7.3 PC program structure

•  Create the Closure data for parameterizing the closure steps

•  Create the Closure data tables for organizing assembly processes

•  Application-related changes to system settings for parameterizing inputs and outputs, operating modes 

and system constants

•  Display of a measurement screen for viewing closing forces and gap values after a closure 

•  Statistics screen for reading the closure data and confirmation of completed pincer tests.

•  Languages file

When the PC program is started a safety instruction message is displayed. Please notice:

Fig. 15 PC program start safety instruction
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8 Structure of the PC program

Fig. 16 PC program menu bar

Menu Submenus
File • New closure data table

• Open closure data tables

• Pincer type overview

• Backup/Restore

• Quit
Pincer test • Request pincer test

• Authorize pincer test

• Nominal force entry
Measure –
Options • Interface

• Force display PC

• Statistics

• Process data

• Password

• Screen scaling

• System settings
Languages –
Help –

Table 2 Main menus in the PC program
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8.1 Preparing to read and send data

Before data can be read or sent using the PC program, the following actions must be carried out:

1. Connect the PC and the ELK 02 (X3 or USB interface) using a data cable (Fig. 10/6, p. 5-23).

2. Power up the ELK 02.

3. In the “Options” – “Interface” menu select “Comport”.

INFO
If no data cable is connected or the ELK 02 is not powered up, the message “Device not responding” will be 

displayed.

8.2 File menu

Fig. 17 File menu

Submenu Description
New closure data table Creates a new closure data table
Open the closure data tables Opens the existing closure data table overview
Pincer type overview Opens a table showing all the pincer types available in the ELK 02 software
Backup/Restore

• Backup

• Restore

Reads all data from the ELK 02 and saves it in a selected file

Copies a selected file back to the ELK 02

Table 3 Submenus in the File menu
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8.2.1 Closure data table new

Creates a new closure data table.

Fig. 18 New closure data table

File menu

Fig. 19 File menu – New closure data table – File

Submenu Description
New INFO

At least one individual closure data view must have been created.

Creates a new, empty closure data table, which is displayed in the closure 

data table overview. You must input a new file name in order to save it
Open Opens an existing closure data table
Save Saves changes to the current closure data table under its existing name. If it is 

a new table, you will be prompted to input a name
Save as Saves the current closure data table under a name and path of your choice 

and copies it as a current table to the overview
Delete Deletes the current closure data table
Main menu Takes you back to the main menu

Table 4 Submenus in the File menu – New closure data table – File
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Edit menu

Fig. 20 File menu – New closure data table – Edit

Submenu Description
Undo Cancels the last action carried out since the data was last saved
New Creates a new individual closure data view  and opens the individual closure data 

view, APN 1
Open (individual view) Opens a individual closure data view to create closure data

Condition: At least one individual closure data view view must have been created.
Copy Copies the currently highlighted closure data table to the clipboard
Insert Inserts a individual closure data view from the clipboard 

You can insert the same individual closure data view from the clipboard more 

than once
Delete Deletes the currently highlighted individual closure data view

The “Delete” command can be undone

Table 5 Submenus in the File menu – New closure data table – Edit
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View menu

Fig. 21 File menu – New closure data table – View

Submenu Description
Sort APN Sorts the APNs in ascending numerical order

Text Sorts the text column in ascending alphanumeric order
Clamp type Sorts the clamp types in ascending alphanumeric order
Pincer type Sorts the pincer types in ascending alphanumeric order
Unsorted Restores the chronological order of the created clamp individual view

Table 6 Submenus in the File menu – New closure data table - View

Sequence menu

INFO
There must be at least two individual closure data view in the stored closure data table.

Define sequence

• A closure data table can have up to 99 individual closure data view.

•  These max. 99 individual closure data view can be defined as a closure sequence in the Sequence table. 

Multiple repeats of the same APN are possible.

• The sequence of up to 30 closures can be freely defined.

• “Sequential closure” mode (see section 9.4.8, p. 9-100).
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Delete sequence

To delete all or parts of a sequence, input the APN “0” in the number of the closure from where you want the 

sequence to be deleted. You must send the sequence in order to update the ELK 02.

• Example:

 –  “APN0” in the 1st closure will delete the entire sequence (send to the ELK 02 to update it).

 –  “APN0” in the 4th closure will delete the sequence from 4 to 30, but 1 to 3 will be retained (send to 

the ELK 02 to update it).

Fig. 22 File menu – New closure data table – Sequence

Submenu Description
Send Sends a sequence to the ELK 02. When the transfer has been completed, the window closes
Read Reads a sequence from the ELK 02. When the transfer has been completed, the window closes
OK Assigns the defined sequence table to this grouped closure data overview, but does not send 

the sequence table to the ELK 02.

The window closes
Discard Discards the sequence input without accepting the changes. The old assignment is retained

Table 7 Submenus in the File menu – New closure data table – Edit
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Data exchange menu

Fig. 23 File menu – New closure data table – Data exchange

INFO
A data set corresponds to the individual closure data view of an APN.

Submenu Description
Send individual data set to 

ELK 02

Opens a window in which a data set from the current table can be sent to the ELK 02 

by inputting the APN. The currently highlighted data set is offered as a suggestion

 Press OK.

The data set is sent to the ELK 02 and overwrites this data set in the ELK 02; all 

others are retained
Send closure data table to 

ELK 02

Sends all data sets displayed (regardless of which is highlighted) to the ELK 02 (max. 

99 data sets). 

The message “Add existing table to the ELK?” appears in the confirmation window

YES  Adds the data sets to the data in the ELK 02 and overwrites existing data 

sets with the same APN number

NO  Deletes the existing data sets in the ELK 02 and copies the current table
Read individual data set 

from ELK 02

You are prompted to specify which data set is to be read back. When you input the 

APN, this data set is read back from the ELK 02. If there is a data set in the table with 

the same APN it will be overwritten. APNs that can be read back are flagged in the 

closure data table
Read closure data table 

from ELK 02 

The message “Add existing data to the table?” appears in a confirmation window

YES  Adds the data to the data sets in the table and overwrites existing data sets 

with the same APN

NO  Deletes the existing data sets in the table and copies assigned data sets 

from the ELK 02 to the table

Table 8 Submenus in the File menu – New closure data table – Data exchange
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8.2.2 Pincer type overview

All the pincer types in the ELK 02 software are listed in tabular form in the “Pincer type overview” menu. 

A password-protected “Send” command copies these in full to the ELK 02. A progress bar shows the progress of 

the transfer.

If pincer types are added or improved, a further password-protected “Send” command copies the pincer type data 

stored in the ELK 02 PC software to the ELK 02.

Fig. 24 Pincer type overview menu

Button Description
Send Sends all the pincer types shown in the overview to the ELK 02
Cancel Takes you back to the File menu
Bar Displays the progress bar
Date Shows the date on which the pincer type file was created or modified

Table 9 Submenu in the File menu – Pincer type overview

Sending pincer types to the ELK 02

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. Click the “Send” button.

The entire pincer type overview is sent to the ELK 02.
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INFO
•  The connected pincer has to be recalibrated after each “Send” operation.

•  If no data cable is connected or the ELK 02 is not powered up, the message “Device not responding” will 

be displayed. 

  Click OK to confirm and repeat the process.

8.2.3 Backup/Restore

Fig. 25 File menu – Backup/Restore

Input box/Button Description
Select file: Choose a backup or restore file
Start backup

Start restore

The selected file is saved (backup) 

Enable to activate (see section 8.5.2 “Inputting the password to edit user rights”)
Cancel Takes you back to the File menu

Table 10 Submenus in the File menu – Backup/Restore

Backing up/restoring data

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. In the “Select file” input box select the desired backup or restore file.

3. Click the “Start backup” button.

All data from the ELK 02 is read and saved in a selected file (backup) or data from a selected file is copied back to 

the ELK 02 (restore).

INFO
The settings and data are copied to a new ELK 02.
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8.2.4 ELK 02 firmware update

Updates the firmware. 

INFO
This function is password-protected and is only available to OETIKER personnel. It only appears when the 

password is input.

8.2.5 Quit 

The PC program closes.

8.3 Pincer test

The pincer test is used to calibrate the pincer for the following:

• the frictional forces in the “friction test”,

• the closing forces in the “force test”

• the closing gaps in the “gap test”

Fig. 26 Pincer test menu

Submenu Description
Request pincer test Opens the “FUNCTION” screen in the ELK 02, in which the pincer test can be requested.
Authorize pincer test •  Allows a pincer test to be performed

•  Authorization is necessary if the pincer test is requested after one of the following 

events:

 –  after a pincer change,

 –  on reaching a predefined number of closures.

 –  via the “External bit pre-selection” interface X2 (see “System settings for 

pincer test”, p. 8-65)

 –  via the “Pincer test” interface X20

•  No separate authorization is necessary if the pincer test is requested from the PC
Nominal force entry Sends the calculated pincer force to the ELK 02

Table 11 Submenus in the Pincer test menu
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Authorization for the Suppress pincer test

Authorization for the pincer test can be suppressed (see “System settings for pincer test”, p. 8-65).

Nominal force entry

NOTICE
In order to ensure uniform and reproducible process quality it is mandatory to perform an assembly tool pincer 

test at least once per shift, minimum daily. Furthermore, a pincer test is mandatory in the event any pincer 

components are replaced.

To maintain consistent pincer force, sufficient compressed air pressure and volume must be provided.

After pincer test, Oetiker recommends verifying the closing force as a secondary validation.

It is essential to ensure clamp closures are not conducted in pincer test mode.

The force correction can be input in various ways:

•  via input in the ELK 02 display under “Force test” – “Correct nominal force”

•  using the CAL 01 (see CAL 01 instruction manual)

•  via the PC; the calculated forces at the pincer jaws are input as the nominal force in the nominal force input 

box (Fig. 27) and sent to the ELK 02.

Fig. 27 Pincer test menu: Nominal force input

1.  Carry out the preparatory steps (see section 8.1, p. 8-32).

2.  In the “Pincer test” menu select “Nominal force entry” and input the calculated nominal force in the input 

box.

3.  Click the “Send” button.
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8.4 Measure

During a closure the close data is copied to the “Measurement” screen with and without hold/detect or contact 

detection, depending on the closure function.

After the closure the status is set to OK or to NO with the error message.

Fig. 28 Measure menu

Output error Description
Closure function F Force priority with verification f

S Gap priority with verification s

D Dual closure with verification d
Status • OK; the closure was successful

• NO; an error occurred (see below)
Error The error message is displayed (see Table 13) 
Save data in file Saves the measurement data in a file
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Output error Description
Select file Chooses the file in which the data is to be saved
Comments Input field for max. 30 alphanumeric characters

Table 12 The most important fields in the Measurement screen

Working with the Measure function

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. Perform the closure.

3. Save the data to a selected file if required.

4. Click the “OK” button.

 The screen closes.

INFO
The “Measurement” screen must remain open throughout the save operation. If the screen is not visible, the data 

will not be saved.

Error Output X2 Output X20
F04 OS - ERROR NO à H NO à H
F05 SK - ERROR NO à H NO à H
F06 SS - ERROR NO à H NO à H
F07 SK + SS - ERROR NO à H NO à H
F09 HK - ERROR NO à H NO à H
F10 HS - ERROR NO à H NO à H
F11 HK + HS - ERROR NO à H NO à H
F12 VK - ERROR NO à H NO à H
F13 VW - ERROR NO à H NO à H
F14 VK + VW - ERROR NO à H NO à H
F16 CANCEL PROCESS NO à H System error à H
F17 NOT ENGAGED NO à H NO à H
F22 DETECTION ERROR NO à H NO à H
F23 LOSS OF PRESSURE NO à H System error à H

Table 13 Error messages in the Error field in the Measurement screen

INFO
Explanation of NO à H: The NO output of the X2 or X20 interface is enabled (H – High) if a NO error is present. A 

24 V signal is then present.
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8.5 Options

Fig. 29 Options menu

Submenu Description
Interface Selects the COM interface in accordance with the computer configuration and has to be 

confirmed with OK.

After establishing a USB link between the PC and the ELK 02, the ELK 02 PC program may need 

to be restarted or the ELK 02 switched off and on again.
Force display 

PC

Switches over the N / lbs unit in the PC (1 N = 0.2247 lbs)

No decimal places are displayed if the value is shown in N
Statistics The values for the closure process that are saved in the ELK 02 can be read for purposes of 

statistical analysis.

The following screens can be used here:

• ELK data (see p. 8-45)

• NO closures (see p. 8-47)

• Pincer test (see p. 8-48)
Process data Process data is password-protected pincer type data, which is only accessible to OETIKER 

personnel
Password To change the password, access service mode or input user rights (see section 8.5.2, p. 8-49)
Screen scaling Adjusts the screen resolution automatically or manually (see section 8.5.3, p. 8-51)
System 

settings

The system settings are used for configuring the following:

• Start function

• Inputs and outputs

• Processes

• Dimensions

• Events

(see section 8.5.4, p. 8-51)

Table 14 Submenus in the Options menu
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8.5.1 Statistics menu

ELK data

Fig. 30 Options menu – Statistics – ELK data 

Input box/checkbox Description
Item No. Shows the item number
Serial No. Shows the serial number
Firmware version Shows the current firmware version
Status of statistics Shows the date on which the statistics were created
Pincer type changes Shows which pincer type was switched to and after how many closures
Total number of closures Shows the number of closures since the date of manufacture of the ELK

This value cannot be reset
Total number of NO closures Shows the number of NO closures since the date of manufacture

This value cannot be reset
Maintenance requirements

Last maintenance at
Shows the number of closures at the last maintenance

Carried out since Shows the number of closures since the last maintenance
Maintenance notice after Shows the factory-specified number of closures after which factory 

maintenance is required

The maintenance notice can be acknowledged so that the user can carry on 

working.
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Input box/checkbox Description
Repeat after Shows the number of closures after which the user is reminded that 

maintenance is required.

INFO
There is no limit to the number of times the reminder can be acknowledged, 

but the reliability of a closure may be compromised.
Print Starts printout of the ELK data
Read Reads all data from the ELK 02 (ELK data, NO closures and pincer test)
Cancel Takes you back to the Options menu

Table 15 Input boxes and checkboxes in the ELK data menu

Reading ELK data:

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. Click the “Read” button.
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NO closures

Displays the NO closures divided between APN numbers 1 to 99.

Fig. 31 Options menu – Statistics – NO closures

Input box/checkbox Description
Delete division Deletes the NO closures
Division deleted on Date of deletion
At...closures Number of NO closures for which the division was deleted
Print Starts printout of the NO closures
Read Reads all data from the ELK 02 (ELK data, NO closures and pincer test)
Cancel Takes you back to the Options menu

Table 16 Input boxes and checkboxes in the NO closures menu

Read NO closures:

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. Click the “Read” button.



OETIKER ELK 02 V2.X 8 Structure of the PC program

Issue 05.2021 08903352 8-48

Pincer tests

Shows the number of closures for which a pincer test was performed, indicating the pincer type and type of force 

calibration, the force setting and the nominal force input.

Fig. 32 Options menu – Statistics – Pincer tests

Input box/checkbox Description
Closures Number of closures for which a pincer test was performed
Pincer type Shows the pincer type for each closure
Force calibration There are two methods of force calibration: 

• Force calibration with constant target value setting

• Force calibration with constant nominal force
Force setting Shows the closing force set for the pincer type in the pincer test (force test)
Nominal force input The calculated value of the closing force that was input
Print Starts printout of the pincer test
Read Reads all data from the ELK 02 (ELK data, NO closures and pincer test)
Cancel Takes you back to the Options menu

Table 17 Input boxes and checkboxes in the Pincer test menu
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Read the pincer test:

1. Carry out the preparatory steps (see section 8.1, p. 8-32).

2. Click the “Read” button.

8.5.2 Password menu

Fig. 33 Options menu – Password 

The default password for accessing the system settings is “ELK02”.

The system settings password can be changed at any time:

1. Input the old password “ELK02”.

2 Input a new password.

3. Input the new password again as verification.

4. Click “OK” to confirm.
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Inputting the password for service mode:

1. Input the password. 

2. Click “OK” to confirm.

Inputting the password for service mode:

1. Input the password. 

2. Click “OK” to confirm.

Inputting the password for service mode:

1. Input the password. 

2. Click “OK” to confirm.

INFO
These user rights remain enabled even after quitting the ELK 02 program.

To disable them, reset (deactivate) the checkboxes.
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8.5.3 Screen scaling menu

Fig. 34 Options menu: Screen scaling

If problems occur with automatic screen scaling, you can set fixed resolutions for the program.

8.5.4 System settings menu

Fig. 35 Options menu: System settings

Submenu Description
Display factory settings Displays the default factory settings
Send factory settings to ELK 02 Sends the factory settings data to the ELK 02
Read settings from ELK 02 Reads data from the ELK 02
Load settings from file Loads the user-defined file

Table 18 Submenus in the System settings menu

General information on function-specific screens in the system settings

• Functions are switched on and off by means of checkboxes or radio buttons ( /  or  / ).

• A * by the checkbox (*) indicates a factory setting.
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START system settings

Defines the START at the trigger unit or at the pincer’s extended trigger along with the inputs at the Start/

Acknowledge interface X2 and the Enable and Start interface X20.

INFO
“Start” means that a closure in accordance with the “closure function” has been initiated.

Fig. 36 START system settings

Input box/checkbox Description
Start / acknowledgement 

via START button or 

external control

• START button

• External control

•  START button or 

external control

START button in the trigger unit EL or in the extended trigger ELT.

External control via the X2 or X20 interfaces 

Start only via START button

Start only via:

• X2 Start/Acknowledge

• X20 Enable and Start

Start via START button or

• X2 Start/Acknowledge

• X20 Enable and Start
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Input box/checkbox Description
•  START button and 

external control

Start only via START button and 

• X2 Start/Acknowledge or

• X20 Enable and Start

NOTICE: This function is a safety function.

The START button can initiate a closure only when the X2 interface: 

Start/Acknowledge or X20:Enable and Start is active
Function on closure:

• Tip

Process pause time (max.)

• Impulse

• Double click

Activation time (min.)

Pause time (max.)

Safe start; in this function initiation must remain activated by means of the START 

button or a current feed via the Start/Acknowledge interface X2 or the Enable and 

Start interface X20 throughout the closure. If initiation is interrupted, the pincer jaws 

open immediately and F16 CANCEL PROCESS appears in the display.

If a second initiation is required during a closure, e.g. “Hold”, the pause must not 

exceed the process pause time. If this time is exceeded, the pincer jaws open 

immediately and F16 CANCEL PROCESS appears in the display.

A pulse of >20 ms at the START button or via the interface

• X2 Start/Acknowledge or 

• X20 Enable and Start, pulse of >20 ms

(see “Start / acknowledgement via START button or external control” in the table 

above)

NOTICE: When the OETIKER ELK 02 is set to “Impulse” operation, you must make 

sure that it is impossible for persons to reach the danger zone during the closure 

operation by installing appropriate guards and safety devices. Supplementing the 

Operating Instructions, the generally valid legal and otherwise binding regulations 

governing accident protection and the generally recognized rules concerning health 

and safety at work apply (see safety instruction Fig. 37).

A double click increases the safety of the start function. 

Two initiations via the START button or via the interface are required

• X2 Start/Acknowledge or 

• X20 Enable and Start

(see “Start / acknowledgement via START button or external control” in the table 

above)

The initiation must take place within a defined time frame:

Range 50 to 2000 ms

Range 50 to 2000 ms

Table 19 START system settings

*see Safety Intructions (p. 8-54).
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Fig. 37 Safety instruction START system settings
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Sequence:

The start time is the time between the initiation of the 

START function and the movement of the pincer jaws.

The start time is determined by the configuration of

PC program – Options – System settings 

OK signal / NO signal / LED function.

• OK signal:  one pulse on initiation of start 

function

• NO signal:  one pulse on initiation of start 

function

• LED function:  one pulse on initiation of start 

function

The delay time between the initiation of the start function 

and the closing movement of the pincer jaws determines 

the longest pulse time for the OK or NO signal or the 

LED function.

System settings for the OK signal

This menu defines the response of the OK output signal at the interfaces. 

• X2 OK

• X20 OK

Fig. 39 System settings for the OK signal

Fig. 38 START diagram
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Input box/checkbox Description
After end of system test:

• continuous signal

• one pulse 

• no output

When the ELK 02 is powered up the control unit checks its function (system test)

The output can be supplied as

• continuous signal

• one pulse (10-1000 ms)

• no output
Read for closure 

• continuous signal

• one pulse 

• no output

•  When “Current APN” appears on the ELK 02 display or 

•  After a closure and display of the following messages on the ELK 02 

display, the ELK 02 is ready for closure:

 – SS + SK OK or

 – SS + SK OK toggling to VW + VK. 

The output can be supplied as

• continuous signal

• one pulse (10-1000 ms)

• no output
NOTICE: If the X20 interface is activated (there is an option to switch between 

the X2 and X20 interface in the “Other” system settings), a separate output is 

available for each of the following statuses:

• BUSY (during the system test) 

• read for closure 
One impulse when closure 

starts

One pulse is supplied when closure starts. 

Factory setting 500 ms (range 10 to 1000 ms)
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Input box/checkbox Description
After each OK closure

• continuous signal The continuous signal remains until the next start

If on opening the pincer jaws (from SS/SK/VW to fully open) the pincer head 

reaches the OS defined at the start time within its tolerance OS-T, a continuous 

signal is output until the next start (factory setting).

• one pulse If on opening the pincer jaws (from SS/SK/VK to fully open) the pincer head 

reaches the OS defined at the start time within its tolerance OS-T, one pulse is 

output (range 10 ... 1000 ms).

• no output
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Input box/checkbox Description
At the end of the sequence 

• continuous signal Continuous signal until the next start.

If the pincer jaw opens (from SS to fully open) in a sequence in the last pressing 

operation and the OS assigned to the last pressing operation is reached within 

its tolerance OS-T, a continuous signal is output until the next start (factory 

setting).

• Pulse If the pincer jaw opens (from SS to fully open) in a sequence in the last pressing 

operation and the OS assigned to the last pressing operation is reached within 

its tolerance OS-T, one pulse is output.

Default 1000 ms (range 10-1000 ms).

• no output
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Input box/checkbox Description
One pulse on reaching the OS Conditions: “Continuous signal” must not be set for “After each OK closure” or 

“At the end of the sequence”.

If the OS is reached within its OS-T, one pulse is output.

Default 500 ms (range 10-1000 ms).

One pulse on reaching the HS 

+ HK

Condition: The Hold function has been pre-selected. If the HS is reached within 

the HS-T and the HK within the HK-T, one pulse is output.

Default 500 ms (range 10-1000 ms).

Table 20 System settings for the OK signal

INFO
The signals are added together if multiple functions are active.
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System settings for the NO signal

This menu defines the response of the NO output signal at the X2 NO and X20 NO interfaces.

Fig. 40 System settings for the NO signal

Input box/checkbox Description
One impulse when closure 

starts

One pulse is supplied when closure starts. 

Factory setting 500 ms (range 10 to 1000 ms) 
After each NO

• continuous signal Continuous signal until the next start.

If the OS defined at the start time is reached within its tolerance OS-T on 

opening the pincer jaws (from SS/SK/VW to fully open), a continuous signal is 

output until the next start (factory setting).

NOTICE: The opening gap (OS) is approached again only after the 

acknowledgement time has elapsed.
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Input box/checkbox Description
• one pulse If the OS defined at the start time is reached within its tolerance OS-T on 

opening the pincer jaws (from SS/SK/VW to fully open), one pulse is output.

Default 1000 ms (range 10-1000 ms).

NOTICE: The opening gap (OS) is approached again only after the 

acknowledgement time has elapsed.
• No output
Data output at X3: on error Data output at X3 on error (see p. 13-124)

Table 21 System settings for the NO signal

INFO
The signals are added together if multiple functions are active.
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System settings for the LED signal

This menu defines the response of the LED function (Fig. 3/12, p. 3-15) in the pincer.

Fig. 41 System settings for the LED function

Input box/checkbox Description
One impulse when closure 

starts

The LED lights up with one pulse when closure starts. 

Factory setting 500 ms (range 10 to 2500 ms).
After each NO

• continuous signal Continuous signal until the next start.

If the OS defined at the start time is reached within its tolerance OS-T on 

opening the pincer jaws (from SS/SK/VW to fully open), the LED lights up until 

the next start (factory setting).
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Input box/checkbox Description
• one pulse If the OS defined at the start time is reached within its tolerance OS-T on 

opening the pincer jaws (from SS/SK/VW to fully open), the LED lights up for the 

length of one pulse.

Default 1000 ms (range 10-1000 ms).

NOTICE: The opening gap (OS) is approached again only after the 

acknowledgement time has elapsed.
• No output

Table 22 System settings for the LED signal

INFO
The signals are added together if multiple functions are active.
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System settings for the LED signal

This menu defines the response of the LED function (Fig. 3/12, p. 3-15) in the pincer.

Fig. 42 System settings for operating modes

Input box/checkbox Description
Operating mode

• Automatic operation

• Step-by-step

Closure mode in which the pincer performs a complete closing sequence when 

a start is initiated, e.g. OS-SS-OF-OS.

Closure mode in which closure has to be initiated separately for each step.
Outputs

•  OK signal pulse on 

completed step, output 

at X2, X20

•  Data output at X3: On 

completed step

With value output

NOTICE: Only in step-by-step mode

When a closure step is completed within tolerance, this is recorded as OK (e.g. 

OS-OK) and pulses can be output.

Pulse/pause (range 10 ... 1000 ms)

Pulses: 1 to 9, 0 corresponds to no output

As above, but with value output F [N], S [mm]

Table 23 System settings for operating modes
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System settings for pincer test

Fig. 43 System settings for pincer test

Input box/checkbox Description
ELK02 - Power ON; 

with mandatory pincer test “ZT”

Pincer test-mode, which asks for a mandatory pincer test when switching on the 

ELK02 (default setting) (“ZT” = pincer test, see Table 27, page 9-74)
ELK02 - Power ON; with 

function selection pincer test 

“ZT” and “APN”*

Pincer test-mode, which allows to choose from two options when switching on 

the ELK02:

• pincer test

• APN (“ZT” = pincer test, see Table 27, page 9-74)
ELK02 - Power ON; without 

function selection, direct to 

active “APN” *

Pincer test-mode, which directly opens the active APN when switching on the 

ELK02

Pincer test prompt by external 

bit pre-selection at X2

The pincer test is activated via the X2 interface.

Default: bit 10 (range bit 10-15)

Activation time: 500 ms (range 20 to 2000 ms).
Pincer test after number of 

closures (counting from last 

pincer test)

Range: 1 to 50,000; factory setting: 5000 

If error message F18 QUANTITY is displayed,

• The pre-set number has been reached

• A pincer test is required
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Input box/checkbox Description
More closures possible Range: 1 to 5000

After this number of closures has been reached, further closures can be 

performed.

NOTICE: A pincer test is mandatory on reaching this number. 
Pulse on pincer test prompt at:

• OK signal

• NO signal

A pulse of an adjustable length can be output at the X2 or X20 interface, at the 

OK or NO output

1 to 5000 ms

1 to 5000 ms
One OK impulse when princer 

tests starts

One OK pulse is output when the pincer test is requested. Range 10 … 1000 ms

One OK pulse after each pincer 

test step
After the friction test, force test, large gap test, small gap test

Check values for plausibility The following checks are performed during the pincer test:

• Stiffness of pincer

• Measuring device check in force test

• Correct gauge sequence

If a fault occurs, the error message F16 CANCEL PROCESS appears on the 

ELK 02 display
Princer test with constant 

nominal force

The force test is performed at a uniform, constant nominal force, the internal 

force setting by the ELK is corrected (see “Pincer tests”, p. 8-48).
Data transmission via X3: 

after every pincer test step

See “Data output at X3 after each pincer test step”, p. 13-120

Pincer test without authorization Disables the authorization prompt at the start of the pincer test
Pincer test can always be 

acknowledged (skipped)

Special function – Service password required for access

Table 24 System settings for pincer test

*see Safety Intructions (p. 8-67).
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Fig. 44 Safety instruction system settings for pincer test
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Other system settings

Fig. 45 Other system settings 

Input box/checkbox Description
Force display of ELK in lbs Switches over the force display from N to lbs (1 N = 0.2247 lbs)

NOTICE: No decimal places are shown in the ELK 02 display
Negation of OK signal 

output

Negates the OK output logic

• L (Low) becomes H (High)

• H (High) becomes L (Low)
Negation of NO signal 

output

Negates the NO output logic

• L (Low) becomes H (High)

• H (High) becomes L (Low)
pincer remains closed in 

case of NO

At the end of the closure the system checks whether the closure data is within 

tolerance. 

For NO closures the pincer remains closed.

Outputs:

• X2 NO becomes H (High)

• X20 Busy becomes H (High)

• X20 NO becomes H (High)

Acknowledge 4 s.

 START button

-or-

 X2 Start/Acknowledge

-or-

 X20 Function and Start

The pincer jaws open again.
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Input box/checkbox Description
Pushbuttons (functions A 

to D) active on ELK

for enabling / disabling the function keys on the ELK

Data Transmission via X3: 

After system test

Data output at X3 after system test (see “Data output at X3 after system test”, 

p. 13-120)
Data Transmission via X3: 

After each closure step

Data output at X3 after each closure step (see “Data output at X3 after each closure 

step”, p. 13-123) 
Data Transmission via X3: 

When ready for closure

Data output at X3 when ready for closure (see See “Data output at X3 when ready for 

closure”, p. 13-122)
Display time 1

Display time 2

If more than one display is needed, e.g.

• with verification or

• with sequential pressing

the display is switched over.

The display times can be adjusted.

Closures with verification

Display time 1: 

Display time for the verification data VW, VK or next APN

(range 500 to 5000 ms).

Display time 2: 

Display time of the closure data SS, SK

(range 500 to 5000 ms).

For closures without verification

Display time 1: 

Display time for the closure and verification data. 

NOTICE: For sequential closure the display switches from 1 or 2 to 3.

Display 3 shows the text of the next APN.
Signal interface

• X2

• X20

• ProfiNet

Switches to one of the following interfaces:

• X2 interface active

• X20 interface active

• ProfiNet

(continued overleaf)
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Input box/checkbox Description
Maintenance requirements After 1’000’000 closures (default setting) the message “F24 MAINTENANCE” appears 

on the ELK 02 display with the information: “send to Oetiker for maintenance”. This 

message is acknowledgeable to do further closures.

Information

Under personal responsibility this number of closures can be changed or the feature 

disabled by setting it 0 (zero).

Repetition

After every 1’000 closures the message “F24 MAINTENANCE” reappears on the 

ELK 02 display and is acknowledgeable (see safety instruction Fig. 46).

Table 25 Other system settings

Fig. 46 Safety instruction system settings, other
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Quitting system settings

INFO
Special function – Service password required for access.

 If changes have been made to the system settings, you are given the option of saving the settings. If no changes 

have been made to the system settings, the program returns directly to the main window.

If changes to the system settings are to be saved, a “Save” dialog window opens (see Fig. 47).

Fig. 47 Save system settings dialog window
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8.5.5 Languages

Fig. 48 Languages

1. Select the language required.

2. Click OK to confirm.

The PC software switches to the selected language

8.5.6 Help

• Contact addresses for OETIKER branches (see also the back cover of this manual).

• Notes on the program

Input box/checkbox Description
Status of process data Date Shows the date on which the pincer type file (process data file) was created or 

modified
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9 Menu navigation in the ELK 02

9.1 Description of the display

The meanings of the ELK 02 display and the buttons below it are as follows:

Fig. 49 Display

Item in Fig. 49 Description
1 Header;

contains the heading, information, error messages, etc.
2 1st … 3rd line:

text; depending on the content only one line may be displayed, but in a larger font
3* Button functions A to D;

various functions are depicted in symbol form here and initiated by the buttons 

below (4)
4* Pushbuttons corresponding to button functions A to D in the display

Table 26 Display

*)  The key functions and the print buttons can optionally be disabled in the system settings. Operation of the 

ELK 02 is then the same as the ELK 01 (ELK 01 mode)



OETIKER ELK 02 V2.X 9 Menu navigation in the ELK 02

Issue 05.2021 08903352 9-74

9.1.1 Symbols and abbreviations in the display

Symbol Description
? Help with problems
i Information, e.g.

• Supply pressure in bar

• Connected pincer type
Parameter input, e.g.

• Brightness

• Contrast

• Languages

Function acknowledgement

APN Active program number;

direct selection of the APN

Takes you to the “Correct nominal force” submenu

Pincer test request: “ZT”;

takes you directly to the pincer test, bypassing the Function menu

 Scrolls down through display texts

 Scrolls up through display texts

 Takes you one step back

OK; confirms an input

Cancel; aborts an input

Table 27 Symbols and abbreviations in the display

9.2 Menu structure

Menu navigation in the ELK 02 consists primarily of the test level and closure level (see also section 4.3, page 4-20).
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9.3 The test level

9.3.1 Button functions A to D enabled

Switch on 
ELK 02

F15 Data store empty

?

F01 INTAKE PRESSURE

?

F02 NO PINCER

?

F03 MEASURING SYSTEM

?

Function
Function selection

Pincer test

F15 Data store empty
Enter pincer data
Load clamp data
Load factory data

F01 Intake pressure
Increase intake pressure

Pincer selection
HO xxxx - xxxx

F02 NO PINCER
Connect pincer
Measuring system defective

F03 MEASURING SYSTEM
Tighten connector screws
Pincer defective

ELK 02
Firmware xxxxx
Creation date xxxxx

APN

2s APN 4s

Parameter input
Brightness
Contrast
Languages

Info
Intake pressure
Pincer type

Brightness

XX

+

Contrast

XX

+

Legend:

OK
Cancel
Acknowledge
Back
up, down

Nominal force 
correction
Pincer test

SKS

P
in

ce
r t

es
t

Fr
ic

tio
n 

te
st

A
P

N

B
ac

k

if APN and APN 4s do not appear on this screen

**

Fig. 50 Sequence of operations at the test level

* Function selection is depending on the selected system settings.
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9.3.2 Button functions A to D disabled (ELK 01-Mode)

Switch on 
ELK 02

F15 Data store empty

?

F01 INTAKE PRESSURE F02 NO PINCER F03 MEASURING SYSTEM Function
Function selection

Pincer test

Pincer selection
HO xxxx - xxxx

ELK 02
Firmware xxxxx
Creation date xxxxx

2s APN 4s

P
in

ce
r t

es
t

Fr
ic

tio
n 

te
st

A
P

N

B
ac

k

if APN and APN 4s do not appear on this screen

* *

Fig. 51 Sequence of operations at the test level (ELK 01 mode)

* Function selection is depending on the selected system settings.
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When the ELK 02 is switched on, the OETIKER logo appears, followed by the firmware version and creation date.

INFO
Prior to use, the ELK 02 should be switched on for approximately 1 hour for warm-up.

The ELK 02 then performs the following checks:

• System tests

 – compressed air supply pE

 – connected pincer type

 – gap measuring system in the pincer

If all ELK checks are OK, one of the following power on modes will be active depending on the selected system 

settings:

a) Default setting: Power On; with mandatory pincer test

b) Optional setting: Power On; operator may select start up mode:

 – pincer test 

or

 – closure level (APNs)

  Prerequisite: The pincer has not been changed.

c) Optional setting: Power ON; without pincer test. Direct start in closure level (APNs)

NOTICE
In order to ensure uniform and reproducible process quality it is mandatory to perform an assembly tool pincer 

test at least once per shift, minimum daily. Furthermore, a pincer test is mandatory in the event any pincer 

components are replaced.

To maintain consistent pincer force, sufficient compressed air pressure and volume must be provided.

After pincer test, Oetiker recommends verifying the closing force as a secondary validation.

It is essential to ensure clamp closures are not conducted in pincer test mode.
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9.3.4 Pincer test

There are 3 modes available to enter the pincer test:

Fig. 52 Pincer test, modes

See “System settings for pincer test”, p. 8-65.

•  The pincer test is used to calibrate the pincer for the following:

•  frictional forces in the “friction test”

•  the closing forces in the “force test”

•  the closing gaps in the “gap test”

A pincer test must be performed each time the ELK 02 is switched on.

The pincer test can be initiated from the following programs:

•  from the “Pincer test” PC program

•  from the calibrator CAL 01 (see the instruction manual for the CAL 01)

The pincer test can be requested via the following interfaces:

•  via the “External bit pre-selection” interface X2 (e.g. bit 10)

•  via the “Pincer test” interface X20

Furthermore the pincer test can be requested:

•  manually from the APN-mode menu using the step back button on the ELK control unit

•  by the internal closure counter, if “Pincer test after number of closures” is activated in the “Pincer test” 

system settings

A pincer test is mandatory after:

•  exchange of a pincer 

Attention
Exchange of pincer is only recognized if the ELK is switched on during the change.

•  aborting an in-progress pincer test

•  error messages F04/F20 

•  switching on the ELK 02 control unit, if the default setting in the “Pincer test” system settings is selected
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The following checks are made during the pincer test:

•  intake pressure F01 

•  loss of pressure F23

•  incorrect, missing or out-of-sequence measuring devices F16
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Friction test

The friction test checks the sliding and friction properties of the pincer and the calibration of the open and closed 

pincer jaws.

Fig. 53 Sequence of operations in the friction test

External interface X2/X20 can be selected via the “System settings” – “Other” menu

1) – X2: Start / Acknowledge 2 s

 – X20: Function 2 s 

2) can be disabled in the system settings

3) – X2: Start/Acknowledge (pulse)

 – X20: Enable and Start (pulse)

4) – X2: Start / Acknowledge 4 s

 – X20: Enable and Start 4 s
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Force test

The force test checks the calibration of the closing force at the pincer jaws between the pre-set value in the ELK 02 

and the measuring devices.

If 20 closures in force test are exceeded the message “F25 MAX. 20 CLOSURES” appears on the ELK 02 display.

When the message is acknowledged, a mandatory pincer test is required again.

INFO
This monitoring prevents the operation of the ELK 02 in pincer test mode.

Fig. 54 Sequence of operations in the force test

External interface X2/X20 can be selected via the “System settings” – “Other” menu

1) – X2: Start/Acknowledge (pulse)

 – X20: Enable and Start (pulse)

2) – X2: Start / Acknowledge 4 s

 – X20: Function 4 s

3) – X2: Start / Acknowledge 2 s

 – X20: Function 2 s
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Gap test

The gap test checks the calibration of the pincer geometry. Four gap tests have to be performed using the test 

gauge corresponding to the predefined display sequence. 

Fig. 55 Sequence of operations in the gap test

External interface X2/X20 can be selected via the “System settings” – “Other” menu

1) – X2: Start/Acknowledge (pulse)

 – X20: Enable and Start (pulse)

2) – X2: Start / Acknowledge 4 s

 – X20: Function 4 s
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9.4 The closure level

Fig. 56 Sequence of operations at the closure level
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9.4.1 The closure

The following parameters can be selected in the individual closure data view:

• Pincer type; when selecting the pincer type, the default settings are defined as

 –   close function

 –   with/without verification

 –   closure options for Low Profile Clamps such as PG192/168T or PG292 via the pincer type code such 

as HO 5000-PG 192.

• Closure function;

 –   Force priority

 –   Gap priority

 –   Dual closure

Other attributes:

• with hold

• with detect

• with contact detection

• verification

The following types, methods and functions can be defined in the “System Settings” PC program and are sent to 

the ELK 02 by data exchange:

• singular closure

• chaotic closure

• sequential closure

• Step by step

INFO
Once the transfer has been performed successfully, the ELK 02 operates autonomously without a PC connection.

The closure sequence with the closing forces and closing gaps and their chronological closing order is defined in 

the Individual closure data view screen (see “Closure data-individual view”, p. 9-86).

Each individual closure data view has an active program number (APN).

The APN used for the closure can be selected via the ELK 02 display (select APN) or via the X2 or X20 interface.

The closure can be initiated by means of the START button (see Fig. 3/12, p. 3-15) on the pincer or externally via the 

X2/X20 interface.
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NOTICE
During the closure the supply pressure is monitored with the necessary closure pressure. The closure process is 

aborted if the pressure drops below this level.

Closure data-individual view

The menu appears when a closure data table is opened.

Fig. 57 Closure data-individual view

Input box/checkbox button Abbreviation Description
APN - Active program number (max. 99)
Text - For a note about the APN
Clamp type - For inputting the clamp type
Pincer type - Selects the pincer type to be used for this closure. The most 

suitable closure function is suggested. You can however change 

it if you wish. The characteristic pincer values, e.g. closing gaps 

and forces, verification data and times, are also set to default 

values. 

The type and number of pincer types is identical to those shown 

in the pincer type overview table.
close function - Selects the closure functions and priorities.

Characteristic pincer data, e.g. closing gaps and forces, are set 

to default values.
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Input box/checkbox button Abbreviation Description

 Open OF The pincer jaws are fully open. At the end of closure the pincer 

jaws are checked to ensure that they are in the fully open state 

(OF). The value for each pincer type is stored in the process 

data.

The maximum time to reach OF is stored for each pincer type.

“F20 OF ERROR” is displayed if an error occurs.

 Open OS The pincer jaws close to the opening gap OS.

At the end of closure the pincer jaws close via OF to OS. The 

system checks for the following:

•  the pincer jaws open to OF, otherwise error “F20 OF 

ERROR”

•  the pincer jaws then move to OS ±OS-T, otherwise error 

“F04 OS ERROR”

The maximum time to reach OS is stored for each pincer type.

NOTICE
OS values that are greater than the fully open pincer jaws are 

ignored and do not lead to an error message.
• Open OF Pincer jaws are fully open
• Opening gap OS Distance between the open pincer jaws, clear width [mm]
• Opening gap tolerance OS-T The opening gap tolerance to be monitored [± mm]
• Removal time OF-Z The removal time between “Pincer jaws fully open again OF” and 

“Closing to opening gap OS” can be defined

 Hold (disabled) No hold function

 Hold (enabled) With hold function

• Holding gap HS Dimension required to hold a clamp without deforming it [mm]
• Holding gap tolerance HS-T The holding gap tolerance to be monitored [± mm]
• Holding force HK Force required to hold a clamp without deforming it [mm]
• Holding force tolerance HK-T The holding force tolerance to be monitored [± mm]

 Detect (enabled) Detection identifies a second closure on the same clamp or Low 

Profile Clamp and reports it as NO.

NOTICE
Hold and detect cannot both be set at the same time.
• Detection gap DS Gap expected by the detection force (DK) to determine whether 

a clamp or Low Profile Clamp is present
• Detection force DK Force that is greater than or equal to the force that must be 

established in the detection gap (DS)
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Input box/checkbox button Abbreviation Description
Closure - The closing values relating to the closing gap SS, closing force 

SK, tolerances and times are defined in the Closure field
Changeover force UK In the case of dual closure, the force at which the changeover 

from force priority to gap priority is performed is input into this 

field

 Contact detection (disabled) No contact detection

 Contact detection (enabled) The contact gap (KS) (distance between the pincer jaws) is 

output when the predefined contact force (KK) is reached.
• Contact force KK The contact gap (KS) is output when the contact force (KK) is 

reached.

Output:

• Measurement screen

• Data output at X3
• Closing gap SS Gap in the closed clamp
• Closing gap tolerance SS-T The closing gap tolerance to be monitored
• Closing force SK Force on the closed clamp

NOTICE
It is critical to use the clamping force established for the clamp together with the specific application.
• Closing force tolerance SK-T The closing force tolerance to be monitored
Times

• Closing time

 -

OF-SK

OS-SK

HS-SK 

for force priority:

Closing time between open (OF) and reaching the closing force 

(SK)

Closing time between the opening gap (OS) and reaching the 

closing force (SK)

Closing time between the holding gap (HS) and reaching the 

closing force (SK)

OF-SS

OS-SS

HS-SS

for gap priority:

Closing time between open (OF) and reaching the closing gap 

(SS)

Closing time between the opening gap (OS) and reaching the 

closing gap (SS)

Closing time between the holding gap (HS) and reaching the 

closing gap (SS)
• SS holding time SS-HZ Holding time between reaching SS and starting to open the 

pincer (for gap priority)
• SK holding time SK-HZ Holding time between reaching SK and starting to open the 

pincer (for force priority)
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Input box/checkbox button Abbreviation Description

 Verification (disabled) No verification

 Verification (enabled)

• Verification value VW Gap in the closed clamp in the verification phase
•  Verification value 

tolerance

VW-T The verification value (VW) tolerance to be monitored

• Verification force VK Force required to detect a verification value (VW)
•  Verification force 

tolerance

VK-T The verification force (VK) tolerance to be monitored

Time

•  Verification force 

holding time

VK-HZ Holding time for the verification force (VK)

Read (disabled) Reads closure data back from the ELK 02
Send (enabled) Sends closure data to the ELK 02
Measure VW Opens the Measurement screen to display the closure values.

Click OK to return to the individual closure data view.
OK VW-T Copies the values from the individual closure data view into the 

closure data table
Cancel VK Discards changed values in the individual closure data view and 

returns to the closure data table.

Table 29 Input boxes and checkboxes in the individual closure data view
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9.4.2 Closure function

Force priority

Function

The force priority closure function closes the pincer 

jaws until their preset closing force (SK) is reached. The 

closing gap setting and tolerances are used to check the 

closing gap (SS) on reaching the pre-selected closing 

force.

At the end of the closing force holding time (SK-HZ) the 

pincer jaws are opened.

The output OK/NO is supplied respectively when the 

pincer jaws have opened (OF) or if the opening gap (OS) 

is too small.

Close pincer jaws from the OPEN position (OF)

The pincer jaws must be open (OF) in order for a closure 

to be initiated. When a “START” is initiated (depending 

on the Start definition: see “START system settings”, 

p. 8-52), the pincer jaws close for the closing time 

(OF-SK) to the pre-selected closing force (SK). Once the 

closing force is reached, the closing force holding time 

(SK-HZ) starts.

Immediately before the end of the closing force holding 

time (SK-HZ) the system checks that the closing force 

is within the closing force tolerance (±SK-T) and that 

the closing gap (SS) is within the closing gap tolerance 

(±SS-T).

The pincer jaws are then opened. When the pincer jaws are fully open (OF) the message OK or NO is output 

(depending on the OK/NO definition: see “System settings for the OK signal”, p. 8-55 and “System settings for the 

NO signal”, p. 8-60).

Fig. 58  
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Gap priority

Function

The Gap priority closure function closes the pincer jaws 

until the preset closing gap (SS) is reached. The closing 

force setting and tolerances are used to check and 

restrict the necessary closing force (SK) on reaching the 

pre-selected closing gap (SS).

At the end of the closing gap holding time (SS-HZ) the 

pincer jaws are opened.

The output OK/NO is supplied respectively when the 

pincer jaws have opened (OF) or if the opening gap (OS) 

is too small.

Advantage: Positioning to an exact closing gap with 

the predefined closing force (SK) as the closing force 

restriction.

Disadvantage: For physical and control technology 

reasons, a slow time must be chosen for the closing time 

from the open position to the closing gap (OF-SS) and 

the opening gap to the closing gap (OS-SS) 

The closing gap (SS) and the resulting closing force (SK) 

are physically interrelated. Fig. 59  
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Close pincer jaws from the OPEN position (OF)

The pincer jaws must be open (OF) in order for a closure to be initiated. When a “START” is initiated (depending 

on the Start definition: see “START system settings”, p. 8-52) via the Start button or the external X2/X20 interface, 

the pincer jaws close to the pre-selected closing gap (SS), provided that this can be achieved with the maximum 

pre-selected closing force. On reaching the closing gap the closing gap holding time (SS-HZ) begins. 

INFO
Once the preset closing force (SK) is reached, the pincer jaws do not close any further.

Immediately before the end of the closing gap holding time (SS-HZ) the system checks that the closing gap is within 

the closing gap tolerance (±SS-T) and that the closing force is within the closing force tolerance (±SK-T). The pincer 

jaws are then opened. When the pincer jaws are fully open (OF) the message OK or NO is output (depending on 

the OK/NO definition: see “System settings for the OK signal”, p. 8-55 and “System settings for the NO signal”, 

p. 8-60).

Close pincer jaws from the OPENING GAP position (OS) 

The pincer jaws must be in the opening gap position (OS) within the opening gap tolerance (±OS-T) in order for a 

closure to be initiated.

When a “START” is initiated (depending on the Start definition: see “START system settings”, p. 8-52) via the Start 

button or the external X2/X20 interface, the pincer jaws close and establish the pre-selected closing gap (SS). On 

reaching the closing gap the closing gap holding time (SS-HZ) begins.

Immediately before the end of the closing gap holding time (SS-HZ) the system checks that the closing gap is within 

the closing gap tolerance (±SS-T) and that the closing force is within the closing force tolerance (±SK-T). 

The pincer jaws are then opened. On reaching the opening gap (OS) within the closing gap tolerance the message 

OK or NO is output (depending on the OK/NO definition: see “System settings for the OK signal”, p. 8-55 and 

“System settings for the NO signal”, p. 8-60).

INFO
•  On completion of the closure the pincer jaws open fully (OF) and then close again as far as the opening 

gap position (OS).

•  The larger the opening gap (OS) that is selected, the less accurate is the opening gap position, as it is 

physically not possible to control very low pressures under the influence of friction.
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Dual closure

Function

Dual closure is an improved type of gap priority closure

The closure starts with force priority until a configurable 

changeover force (UK) is reached, when the closure 

switches from force priority to gap priority. 

The changeover force (UK) must be up to approx. 10 % 

less than the force required to achieve the closing gap 

(SS). 

The value set for the closing force (SK) limits the actual 

closing force value during closure.

The value set for the closing force (SK) should be at least 

30 % greater than the anticipated value of the closing 

force (SK), so as to obtain sufficient control freedom.

Depending on the closure data, the pincer jaws are 

opened (OF), opening gap (OS) with and without 

verification.

Fig. 60  
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9.4.3 Pincer type

HO XX-XX-PG 192 /168 T1

Function 

Force priority closure with pincer type PG 192 / 168T1 

closes Low Profile Clamps, e.g. PG 192 / PG 168T1, 

for which the closing movement has to be stopped 

immediately after the retaining hook engages.

Then the system checks that the Low Profile Clamp has 

been closed correctly.

Close pincer jaws from the OPEN position (OF)

The pincer jaws must be in the OPEN position (OF) in 

order for a closure to be initiated.

When a “START” is initiated (depending on the Start 

definition: see “START system settings”, p. 8-52)) via the 

Start button or the external X2/X20 interface, the pincer 

jaws close with the closing time between the opening 

gap and the closing force (OF-SK).

From the closing gap (SS) plus the positive +(SS-T) value 

onwards, the closing process is ready to stop the closing 

force (SK) once it detects that the retaining hook has 

engaged.

If this is not detected, the pincer jaws close until they 

reach the closing gap (SS) minus the -(SS-T) value or 

until they reach the preset closing force (SK). Then the 

pincer jaws open with the error message F17 NOT ENGAGED.

If the Low Profile Clamp engages, the system switches immediately to the verification force, but the pincer jaws 

remain in frictional connection with the Low Profile Clamp in order to ensure a secure engagement by means of the 

verification value (VW) and the verification value tolerance (VW-T).

Immediately after the verification force holding time (VK-HZ) the system checks that the verification value (VW) is 

within the verification value tolerance (VW-T) and that the verification force (VK) is within the verification tolerance 

(VK-T).

The pincer jaws are then opened. When the pincer jaws are fully open (OF) the message OK or NO is output 

(depending on the OK/NO definition: see “System settings for the OK signal”, p. 8-55 and “System settings for the 

NO signal”, p. 8-60).

The verification value (VW) is the difference between the closing gap when the maximum closing force is applied 

and the position when the tensioning hook and tensioning tunnel are correctly engaged.

Fig. 61 
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HO XX-XX-PG 292

The closure function is “force priority with verification” and is described in the detail descriptions for force priority & 

verification.

9.4.4 Verification

Verification  is available for all

•  closure functions

•  pincer types

•  other attributes

•  types, procedures and functions (see system  

settings).

On expiry of the closing force holding time (SK-HZ) or 

closing gap holding time (SS-HZ) the force is reduced to 

the verification force (VK).

At the end of the verification force holding time (VK-HZ) 

the system checks that the verification force (VK) is 

within the verification tolerance (±VK-T) and that the 

verification value (VW) is within the verification value 

tolerance (±VW-T).

The pincer jaws are then opened. When the pincer jaws 

are fully open (OF) the message OK or NO is output 

(depending on the OK/NO definition: see “System 

settings for the OK signal”, p. 8-55 and “System settings 

for the NO signal”, p. 8-60).

Fig. 62  
ELK 02 display

If the closure is OK, the display alternates between showing the values of the closing force (SK) and the closing gap 

(SS) and the value of the verification force (VK) and the verification value (VW).

Fig. 63  
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9.4.5 Initiating closure with “START”

Function

The START function can also be initiated by energizing the following external inputs:

• X2 Start/Acknowledge

• X20 Enable and Start

• START button 

• or a combination.

Sequence

The start time is the time between the initiation of the 

START function and the movement of the pincer jaws.

This time is determined by the configuration of

•  OK signal, “one pulse on initiation of start 

function” setting (see “System settings for the 

OK signal”, p. 8-55)

•  NO signal, “one pulse on initiation of start 

function” setting (see “System settings for the 

NO signal”, p. 8-60)

•  LED function, setting “one pulse on initiation 

of start function” setting (see “System settings 

for the LED signal”, p. 8-62)

The delay time between the initiation of the start 

function and the closing movement of the pincer jaws 

determines the longest pulse time for the OK or NO 

signal or the LED function. Initiation takes place in 

• touch mode

• pulse mode;

– single or double click, 

– via the START button or 

– externally via the X2 or X20 inputs (see section “8.5.4 System settings menu”, p. 8-51).

Closure sequence in touch mode

INFO
“Touch mode” is a safe way of working.

For safety reasons the closure sequence for the ELK 02 electronically controlled pneumatic pincer has been 

factory-set to touch mode. 

Fig. 64 
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  Press and hold down the Start button for the duration of the closure sequence. 

  If the Start button is released, the closure sequence stops immediately. The pincer jaws open immediately.

Closure sequence in pulse mode

For operation in automated assembly processes it is possible to run the unit in “pulse mode”.

 WARNING
Risk of crushing at the pincer jaws of the pincer head!

In “pulse mode” the closure sequence can be initiated by means of transient external signals and/or by pressing 

the Start button.

  In pulse mode stay clear of the pincer jaws during the closure sequence.

  In addition to the instructions in the manual, the generally applicable legal and other binding regulations 

governing accident prevention and other generally recognized health and safety rules must be observed.

If the closure sequence is activated in pulse mode, the 

adjacent safety notice will be displayed:

  Once you have read the safety notice, click OK 

to confirm.

Fig. 65  
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9.4.6 Singular closure

Function

Close in accordance with an APN individual closure data 

view.

Sequence

Send closure data for up to 99 APNs.

PC program: 

• Close data table 

• Send individual closure data view

or

• Data exchange

• Send table to ELK 02

Select an APN:

1. In the ELK 02 display select “Function” – “APN”.

– In the “Current APN” display select “APN”

–  In the “Select APN” display use the q p 

buttons to select the APN you want and confirm 

with ü.

or

2. Select an APN externally.

Fig. 67  

Fig. 66  
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9.4.7 Chaotic closure

Function

Send multiple sets of APN closure data in any sequence 

and perform any number of closures.

Sequence

  Send closure data for 1 to 99 APNs using the 

PC program via the ELK 02 display, see section 

9.4.6 “Singular closure”.

Select an APN, see section 9.4.6, p. 9-98.

Example: Setting bits 3, 1, 4, 2 to select closure data 

(APNs).

Fig. 68  
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9.4.8 Sequential closure

Function

Close multiple APN closure data sets in sequential order.

Sequence

Send the closure data of at least 2…99 APNs using the PC program.

Create a sequence:

1.  In the Closure data table open the “Sequence” menu (see “Sequence menu”, p. 8-35).

2.  Assign any APN from 1 to 99 to the 30 possible closures.

  The sequence ends with the closure in which APN 0 is selected.

3.  Send the sequence to the ELK 02.

INFO
The order of the APNs determines the sequence. 

No APNs may be selected at the X2/X20 inputs.

Fig. 69 Sequential closure
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Initiate closure 

  Press the Start button on the pincer.

or

  Initiate the Start function via the external X2/X20 

interface.

 – X2: Start/Acknowledge 

 – X20: Enable and Start

Perform the closure

The order of the APNs determines the sequence 

(example).

1.  Perform the first closure APN3.

2.  If OK, continue with the second closure APN1.

3.  If NO, you must repeat the APN until an OK 

message is received.

4. Perform closure of the last APN.

Depending on the setting in the “System settings for the 

OK signal” menu (see p. 8-55), a continuous signal, a 

pulse or no output appears at the end of the sequence. 

Example: Sequential closure of APN3, APN1, APN4 with 

a pulse on OK and a continuous signal at the end

Fig. 70 
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Removal time OF-Z

The removal time OF-Z is relevant only in sequential 

closure with an active opening gap (OS). It is the time 

between the last opening to OF (fully open) and closing 

to the new opening gap (OS). The removal time to  

closing to the OS is assigned to the corresponding APN.

INFO
A removal time OF-Z is necessary if the next APN has 

a smaller opening gap (OS) than previous APNs.

Fig. 71  
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9.4.9 Closure step-by-step

Function

Step-by-step closure with the following variants, in 

which each step is initiated with “START”:

1.  from open (OF) to the opening gap (OS)

2.  from the opening gap (OS) to hold (HS)

3.  from hold (HS) to close (SS, SK)

4.  from close (SS, SK) to verify (VW, VK)

5.  from verify (VW, VK) to open (OF)

1.  from open (OF) to the opening gap (OS)

On reaching the hold, close and verify position the 

measured values HK, HS, SS, SK or VW, VK are 

continuously displayed on the ELK 02 display.

Sequence

1.  On the PC program select

 – “Options”

 – “System settings”

 – “Operating mode”

 –  Step-by-step radio button (see “System 

settings for operating modes”, p. 8-64). 

2.  Click the “Send” button.

  The values are sent to the ELK 02.

Initiate closure 

• START button

•  Initiate the Start function via the external X2/X20 

interface:

 – X2: Start/Acknowledge 

 – X20: Enable and Start

Fig. 72 
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9.4.10 Closing with hold

Function

With “hold” it is possible to hold a clamp with a low 

force (holding force) in such a way that the pincer jaws 

hold the clamp but do not change its geometry.

Sequence

The pincer jaws must be open (OF) or the opening gap 

(OS) must be within its opening gap tolerance (±OS-T) in 

order for a closure to be initiated.

When a “Start” is initiated (Start definition: see section 

9.4.5, page 9-96), the pincer jaws close until they touch 

the clamp ear. The force acting on the ear is defined in 

the holding force (HK).

On reaching this position the system checks that the 

holding gap (HS) is within its holding gap tolerance 

(±HS-T) and that the holding force (HK) is within its 

holding force tolerance (±HK-T).

At the same time the measured HK and HS values are 

continuously displayed on the ELK 02 display.

The retention time can be as long as you wish.

If a NO is signaled, one of the following error messages 

appears:

• F 09  HK-Error

• F 10  HS-Error

• F 11  HS-Error

Fig. 73  
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Message on OK signal

If an OK is signaled, an OK message can be output.

Setting: 

  In the PC program under “Options” – “System settings” – “OK signal” activate the “One pulse on reaching 

the HS + HK” checkbox and input a time in the “ms” field (see “System settings for the OK signal”, p. 8-55).

When a “Start” is initiated (depending on the Start definition) the pincer jaws close in accordance with the force or 

gap priority function.

Canceling the hold operation

Using the START button:

  Hold down for 4 s.

Using the X2 interface:

1. Energize with “Start/Acknowledge” for 4 s.

2. The pincer jaws open.

NO à H

Using the X20 interface:

1. Energize with Reset.

2. The pincer jaws open.

System error à H

Error message F19 RESET CANCEL is displayed.

9.4.11 Closure with detect

Function

Detection identifies a second closure on the same clamp or Low Profile Clamp and reports it as NO.

Sequence

During the closure operation, on passing the detection gap (DS) the system checks whether the actual detection 

force (DK) is greater than the predefined value. If the detection force is lower or no detection force is present, the 

pincer opens and a NO is signaled together with the error message F22 DETECTION ERROR.

INFO
• Default value for the detection gap (DS):

 – Detection gap (DS) = closing gap (SS) plus closing gap tolerance +(SS-T) + 0.5.

• The default value for the detection force (DK) is calculated when the “Detect” checkbox is enabled.

• The detection force must be greater than 100 N.
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9.4.12 Closure with contact detection

Some OETIKER products, e.g. Low Profile Clamps, can be reduced in diameter to the required engagement position 

– closing gap (SS) – without systematic plastic deformation. A compression and hence a cross-section reduction of 

the corresponding material being clamped, e.g. elastomer, is generated before the closing gap (SS) is reached.

The contact detection function determines the contact position of the corresponding clamp with the material being 

clamped at the start of compression. Following closure, the contact position is output in the form of the measured 

contact gap (KS) (distance between the pincer jaws) on reaching the predefined contact force (KK) in relation to the 

particular application. Depending on the chosen contact force (KK), the material being clamped may already have 

been compressed. This can lead to inaccuracies in determining the contact gap (KS).

Corresponding clamp products are secured with a transit lock to prevent them from opening accidentally during 

transportation or handling. The desired diameter reduction for fitting this clamping product only begins once the 

product-specific resistance force of the transit lock has been exceeded. For process control reasons the selected 

contact force (KK) generally has to be greater than this resistance force. Suitable tests should be carried out with 

several components to determine the appropriate contact force (KK) for a specific application and product.
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10 Maintenance and repairs

10.1 General safety instructions for maintenance and repair work

•  Cleaning, lubrication and maintenance work should only be carried out by authorized technical personnel in 

accordance with these maintenance instructions and accident prevention regulations. 

 Failure to observe these instructions and regulations may lead to personal injury and property damage. 

•  For maintenance and repair work only use tools and original equipment from OETIKER.

•  Isolate the ELK 02 from the electrical supply and compressed air supply before starting maintenance work. 

Isolate the unit from the compressed air supply using the swivel coupling provided, and pull the main plug 

out of the electrical outlet.

•  Following initial commissioning, the ELK 02 unit should be cleaned daily or weekly, depending on the degree 

of soiling.

•  Never immerse the ELK 02 in water or other liquids.

10.2 Maintenance

10.2.1 Before maintenance work

  WARNING
Danger of death from electric shock!

Touching live parts can result in death.

  Pull the main plug out of the electrical outlet and secure it to prevent it from being plugged in accidentally.

  Ensure that only qualified and authorized electricians work on the electrical equipment.

  Ensure that operators only rectify faults that are clearly attributable to operating or maintenance errors.

10.2.2 After maintenance work

•  Ensure that disconnected pneumatic and electrical plug connectors are plugged in again following the 

maintenance and inspection work.

•  Check all screw connections.

•  Reattach all safety equipment immediately.

•  Check all functions of the ELK 02.
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10.2.3 Weekly preventive maintenance jobs

Pincer head

The rollers and plunger on the pincer head are subject to mechanical loading. When the ELK 02 is in regular use, 

they must be lubricated at least once a week.

Description Type Manufacturer
Grease RENOLIT LX EP 2 (RENOLIT DURAPLEX EP 2) FUCHS PETROLUB AG

Friesenheimer Str. 17
68169 Mannheim, Germany
Telephone No.  +49 (621) 38 02-00
Fax  +49 (621) 38 02-1 90
www.fuchs-oil.de 

Table 30 Recommended lubricant

1.  Disconnect the compressed air supply and 

switch off the ELK 02 control unit.

2.  Using a grease gun, lubricate the pincer head 

(Fig. 74/1) at the grease nipple (Fig. 74/3) with 

RENOLIT LX-EP 2 grease (RENOLIT Duraplex 

EP 2).

3.  Check the pincer jaws (Fig. 74/2) for wear and 

chipping at the clamping points, and replace if 

necessary (see tools catalog for item number).

4.  Check the pincer and control unit for mechanical 

damage.

5. Replace defective parts.

Fig. 74 Lubricating the pincer head

10.2.4 Annual preventive maintenance jobs

When the OETIKER EL (T) electronically controlled pneumatic pincer is in regular use, we recommend an annual service. 

Please contact OETIKER and return the OETIKER EL (T) electronically controlled pneumatic pincer to OETIKER.

10.2.5 Other preventive maintenance

At regular intervals, inspect the pre-filter for soiling and replace if necessary. The pre-filter must remain fitted at all 

times for trouble-free operation. 

The recommended filter (item no. 05005930) has a 5 µ screening function.

Other recommended filters or pre-filters:

•  FESTO, type LF-M1-G1/4-CS, item no. 182 632, and as a pre-filter in heavily contaminated air FESTO, type 

LF-M2-G1/4-ES.

• Corresponding holders, e.g. LFPC-M2 or LFPE-M2.
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10.3 Repairs

10.3.1 Changing the pincer jaws

INFO
Replacement pincer jaws are available fully assembled in the form of jaw repair sets. In order to ensure the fast 

and accurate delivery of spare parts, a clear purchase order is essential. 

It must include the following information:

Product name, item number, shipping method, full address. 

Corresponding technical details can be found in the tools catalog.

Changing the pincer jaws – HO pincers

There is a number engraved on the pincer jaws. You can use this number to order a pincer jaw replacement kit (see 

also the tools catalog). Only fit the designated pincer jaw type in the pincer head.

NOTICE
Damage to the pincer from third-party parts.
 Only use original OETIKER pincer jaws. Only fit the designated pincer jaw type in the pincer head.

1.  Disconnect the compressed air supply and switch 

off the ELK 02 control unit.

2.  Detach the pincer unit from the ELK 02 control 

unit.

3.  Loosen the lock nut (Fig. 75/1) and unscrew the 

union nut (Fig. 75/2).

Fig. 75 Unfastening the pincer head
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 CAUTION
The compression spring (Fig. 76/4) is under tension.

  Hold on to the pincer head (Fig. 76/6) as you 

remove it.

4.  Separate the pincer head (Fig. 76/6) from the 

pincer body (Fig. 76/3).

  The plunger (Fig. 76/5) and plunger piston 

(Fig. 76/7) remain in the pincer body (Fig. 76/3). 

5.  Remove the two retaining rings (Fig. 77/9) on the 

pincer head (Fig. 77/6) on the grease nipple side. 

 Do not push the pins back (Fig. 77/10).

6.  Unscrew the two hex nuts (Fig. 77/8) from the 

hex bolts (Fig. 77/11).

7.  Remove the pincer plate (Fig. 78/12).

Fig. 76  Separating the pincer head from the pincer 
body

Fig. 77 Dismantling the pincer head

Fig. 78 Removing the pincer plate
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8.  Remove the compression spring (Fig. 79/14), 

cover plates (Fig. 79/15) and pincer jaws 

(Fig. 79/13).

9.  Grease the replacement pincer jaws (Fig. 79/13) 

and compression spring (Fig. 79/14) from the 

pincer jaw replacement kit with RENOLIT LX-EP 

2 grease (RENOLIT Duraplex EP 2) and install.

10.  Mount the pincer plate (Fig. 78/12). Guide the 

cover plates on each side (Fig. 79/15) into the 

grooves (Fig. 79/16) in the pincer plate.

11.  Check that the pincer jaws (Fig. 79/13) are 

moving freely.

12.  Screw the pincer head (Fig. 76/6) onto the pincer 

body (Fig. 76/3) and secure with the lock nut 

(Fig. 75/1). 

  The plunger (Fig. 76/5) must be centered 

between the two pincer jaws.

Fig. 79 Removing the pincer jaws
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10.3.2 Changing the pincer head

 WARNING
Risk of injury when pincer head is not mounted.

Starting a closure can cause the compression spring and plunger to be ejected and cause injury if the pincer head 

is not mounted.

 Never operate the pneumatic pincer unless the pincer head is mounted.

INFO
Each pincer body is compatible with different pincer heads. The type designations can be found in the tools 

catalog.

Scope of supply of a pincer head set

• Lip seal (Fig. 80/1)

• Piston ring with plunger piston (Fig. 80/2)

• Pincer head (Fig. 80/3)

• Wedge (Fig. 80/4)

• Compression spring (Fig. 80/5)

• Spacer shim (Fig. 80/6)

Fig. 80 Pincer head set
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Installing the pincer head set

1.  Disconnect the compressed air supply and 

switch off the ELK 02 control unit.

2.  Detach the pincer unit from the ELK 02 control 

unit.

3.  Separate the pincer head (Fig. 81/7) from the 

pincer body (Fig. 81/1) (see section 10.3.1, 

p. 10-109).

4.  Remove the plunger (Fig. 81/5), plunger piston 

(Fig. 81/4), piston ring (Fig. 81/8), lip seal 

(Fig. 81/3) and compression spring (Fig. 81/6) 

from the piston body (Fig. 81/1).

5.  Lubricate the plunger piston (Fig. 81/4), plunger (Fig. 81/5), piston ring (Fig. 81/8) and lip seal (Fig. 81/3) from 

the new piston head set and mount them in the piston body.

 –  Piston ring (Fig. 81/8) and lip seal (Fig. 81/3) with RENOLIT IPR 2, OETIKER item no. 08901485.

 –  Plunger (Fig. 81/5) with RENOLIT LX-EP 2 (RENOLIT Duraplex EP 2), OETIKER item no. 08901490.

NOTICE
Damage during installation!

 Be careful not to damage the piston ring (Fig. 81/8) and lip seal (Fig. 81/3) during installation.

6.  Mount the compression spring /6).

7.  Screw the new pincer head (Fig. 81/7) on to the pincer body (Fig. 81/1) and secure with the lock nut 

(Fig. 75/1). 

  The plunger (Fig. 81/5) must rest between the two pincer jaws.

Fig. 81 Replacing the pincer head set
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11 Decommissioning, storage, recommissioning

11.1 Decommissioning and storage

If the ELK 02 pneumatic pincer is to remain out of service for an extended period, it must be decommissioned.

• Disconnect the pneumatic and electrical plug connectors on the ELK 02.

• Clean the ELK 02 pneumatic pincer before putting it into storage.

• Replace defective parts.

• Store the ELK 02 in a clean, dry location and protect from dust.

11.2 Recommissioning

• Please refer to the HO pincer instruction manual for details of the commissioning procedure.
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12 Disposal

Dispose of packaging materials in accordance with local regulations. 

The unit, all replacement parts and in particular used operating fluids or other environmentally polluting substances 

must be disposed of by specialist firms in accordance with applicable statutory regulations.
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13 Technical data

13.1 Electrical connection and interfaces

Fig. 82 Control unit, connections

13.1.1 Main plug

(see Fig. 82/8)

 WARNING
Electric shock if PE conductor (protective earth conductor) not fitted!

 The main power supply must always be protected with a PE conductor.

3-pin IEC connector (male)

Operating voltage:  85 - 265 V 47 - 63 Hz

Power consumption:  30 VA

INFO
10 A backup fuse recommended.
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Fig. 83 Connection diagram for the X2 interface

13.1.2 X1 interface

(see Fig. 82/2)

• 9-pin SUB-MIN-D (male)

• Pincer connection

13.1.3 X2 interface

(see Fig. 82/3)

15-pin SUB-MIN-D (HD) (male)

INFO
The cable must be fitted with a ferrite ring at the cable 

end near the X2 interface.

Inputs:Start/Acknowledge/bits 1 ... 8

•  Input data for setting Start/Acknowledge/ 

 bits 1 to 15

•  Opto-decoupled inputs

 (dedicated GND PIN 15, for all bits)

Nominal value  DC 24 V

Signal “0”  0 ... 5 V

Signal “1”  15 - 30 V 

  (> 100 ms for start)

Input current 10 mA (at 24 V)

Outputs: OK/NO/digital

•  Output data (digital)

•  Opto-decoupled outputs (dedicated GND PIN 5 

for OK/NO)

Operating voltage UB DC 24 V (max. 30 V)

Output for connecting lamps, relays, etc.

Output current IA  X2.1 or X2.4 < 100 mA

Output voltage   Operating voltage UB less approx. 1 V

Output for connection to PLC

Output current IA X2.1 or X2.4 < 10 mA

Output voltage Operating voltage UB – (IA x 470 Ohm)

Example:  24 V – (0.01 A x 470 Ohm) = 19.3 V
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X2 inputs and outputs

Symbol Description
1* NO Collector IA < 100 mA
2* NO Collector with R470 series resistor
3* OK Collector with R470 series resistor
4* OK Collector IA < 100 mA
5 GND for pin 1 to 4
6* BIT 1 Selection for closure data (APNs)
7  NC
8 XS UA = f (gap SS) 0 to 5 V
9 XF UA = f (force SK) 0 ... 5 V
10 GND for pin 8 + 9
11* BIT 2 Selection for closure data (APNs)

12* BIT 4 Selection for closure data (APNs)
13* START/Acknowledge START/ACKNOWLEDGE selection
14* BIT 8 Selection for closure data (APNs)
15 GND GND for pin 6, 11, 12, 13, 14
HOUSING PE Protective earth conductor

Table 31 X2 interface inputs and outputs

*) opto-decoupled

XS/XF outputs

The two analog outputs, pin 8 and 9 referenced to pin 10 (GND) (output voltage 0 to 5 V, 

output load > 1 M), are suitable for displaying the gap (S) or force (F) values, in particular for visual display on 

dynamic display devices (oscilloscope).
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Application of the OK/NO outputs

Two mutually independent outputs are available for the NO and OK functions.

These outputs are opto-decoupled “open collectors”, i.e. an external operating voltage is required in order to 

energize them.

The three examples below show the following connections:

• Connection for PLC

• Connection for lamps

• Connection for LEDs

Fig. 84 Connection examples for OK/NO outputs
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13.1.4 X3 interface (RS232)

INFO
The cable must be fitted with a ferrite ring at the cable end near the X3 interface.

• 9-pin SUB-MIN-D (female)

• PC connection  RS232 (for communicating with the ELK 02 software)

• CAL 01 connection RS232 (for communicating with the CAL 01 calibrator)

• 9600 baud

• 8 data bits

• 1 stop bit

• Priority: even

• Protocol/handshake: none

• Value separator: tab (chr $09)

• End of line: CR/LF (chr $0D/chr $0A)

•  All outputs take the form of readable ASCII characters. Individual values are separated by tabs. Lines end 

with CR/LF (chr $0D/chr $0A).

Data output at X3 after system test

Message text Meaning
_001 SystemTestOK The system test was successfully completed
_010 PincerTestPrompt1 ELK 02 is waiting for confirmation or acknowledgement of the prompt via 

the Start button or start signal
_600 UserCancel The user has skipped the pincer test
_002 Ready for closure ELK 02 is in the closure level and is waiting for a start from the user

Table 32 Data output at X3 after system test

Data output at X3 after each pincer test step

Message text Meaning
_001 SystemTestOK The system test was successfully completed
_020 PincerTestPrompt2 The ELK 02 is waiting for confirmation of the prompt via the Start button or 

start signal. A pincer test must be performed
_100 PincerTestStart The user has confirmed the prompt.
_110 PType: HO 3000 3m/xxx The current process data is suitable for “HO 3000 3m” pincers. 

The ELK 02 is waiting for the friction test to be started
_120 FrictionTestStart The friction test was started and performed by the user
_130 FrictionTestEnd The friction test was completed
_200 ForceMeasurementStart The ELK 02 is waiting for a force closure to be started
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Message text Meaning
_210 FN: 2100 N The reference value for the force closure is currently 2100 N.
_210 FN: 2100 N A force closure has been started; the reference value is still 2100 N
_290 ForceMeasurementEnd The reference value of 2100 N was confirmed by the user
_300 GapMeasurementStart Gap measurement has started; the ELK 02 is waiting for the 1st gauge to 

be started Measurement gauge
_310 Gauge_1_1_End Measurement for gauge 1 has been completed; the ELK 02 is waiting for 

the 2nd gauge to be started Measurement gauge
_320 Gauge_1_2_End Measurement for gauge 2 has been completed; the ELK 02 is waiting for 

the 3rd gauge to be started Measurement gauge
_330 Gauge _2_1_End Measurement for gauge 3 has been completed; the ELK 02 is waiting for 

the 4th gauge to be started Measurement gauge
_340 Gauge_2_2_End Measurement for gauge 4 has been completed; the ELK 02 is calculating 

the results of the gap measurement
_390 GapMeasurementEnd The calculations have been completed
_500 PincerTestEnd The pincer test has been successfully completed
_002 Ready for closure ELK 02 is in the closure level and is waiting for a start from the user

Table 33 Data exchange at X3 after each pincer test step

The following data protocol has been implemented to allow the nominal force to be corrected during the pincer test:

PC output Meaning Number of characters
“PDFN” “Force nominal” parameter 4
“=“ Parameter should be set to new value 1
“1234” New value (decimal) 4
TAB (chr $09) Value separator 1
STX (chr $02) Control character STX 1
“$00D3” Checksum (hexadecimal) 5
CR (chr $0D) Carriage return 1
LF (chr $0A) Line feed 1

Table 34 Data protocol for nominal force correction

The checksum is the sum of all characters between “=“ and “STX” (exclusive) in 4-digit hexadecimal notation.



OETIKER ELK 02 V2.X 13 Technical data

Issue 05.2021 08903352 13-122

Data output at X3 when ready for closure

• Standard data output by the ELK 02 after each closure:

The data output occurs at X3 after every closure or with hold or detect, close or verify.

Each value is followed by a tab character as a separator. The data set is ended with a carriage return and line feed.

• On initiation of a closure in automatic mode:

Message text Meaning
_002 Ready for closure The ELK 02 is at the closure level and is waiting for a start from the user

V24 standard data output Hold
Clamp type Pincer type Text H V 9.0 4.0 4.0 9.03 300 150 150 298 0   OK

V24 standard data output Close
Clamp type Pincer type Text S V 6.7 9.0 9.0 9.08 900 900 2000 1042 0   OK

V24 standard data output Close
Clamp type Pincer type Text V V 8.0 2.5 2.5 9.18 20 20 20 22 0   OK
_002 Ready for closure The ELK 02 is at the closure level and is waiting for a start from the user

Table 35 Data output ready to close for closure in automatic mode
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Data output at X3 after each closure step

Message text Number of 

characters
Clamp type 16
Pincer type 30
Free text 16
Function (C / H / D / K / S / V) * 1
Priority (F / f / S / s / D / d) ** 1
Target values: holding gap or detection gap / closing gap / verification gap 4
+ tolerance settings: holding gap / closing gap / verification gap 4
- tolerance settings: holding gap / closing gap / verification gap 4
Actual values: holding gap or detection gap / closing gap / contact gap / verification gap 4
Target values: holding force or detection force / contact force / closing force / verification force 4
+ tolerance settings: holding force / closing force / verification force 3/4
- tolerance settings: holding force / closing force / verification force 3/4
Actual values: holding or detection force / closing force / contact force / verification force 4
Error number 1/2
Status OK, NO-OK 2/5

Table 36 Data output at X3 after each closure step

*) Function

C  Clear (Ctrl Del); sends zero value for all 

measured values when closure is initiated

H Holder and measured value

D Detect and measured values

K Contact detection and measured values

S Close and measured values

V Verify and measured values

**) Priority

F Force PRIORITY

f Force priority with verification

S Gap PRIORITY

s Gap priority and verification

D Dual closure

d Dual-closure with verification
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Data output at X3 on each completed step in step-by-step

Message text Meaning
_002 Ready for closure The ELK 02 is at the closure level and is waiting for a start from the user
OS-OK The opening gap has been reached. The ELK 02 is waiting for the hold 

function to be started
F:___0 N Force value for opening gap
S:_9,99 mm Opening gap
HS-OK Holding gap and holding force have been reached. The ELK 02 is waiting for 

the closure function to be started
F: 344 N Holding force
S: 10.87 mm Holding gap

V24 standard data output (only if this function is enabled)
Clamp type Pincer type Text H V 12.0 4.0 4.0 10.87 300 150 150 344 0   OK
SS/SK-OK Closing gap and closing force were reached. The ELK 02 is waiting for the 

verification function to be started
F: 5035N Closing force
S: _3.76 mm Closing gap

V24 standard data output (only if this function is enabled)
Clamp type Pincer type Text S V 9.0 9.0 9.0 3.76 5000 250 250 5035 0   OK
VW-OK Verification gap and verification force have been reached. ELK 02 is waiting 

for the opening function to be started
F:__84N Verification force
S:_2.34 mm Verification gap

V24 standard data output (only if this function is enabled)
Clamp type Pincer type Text V V 2.0 1.5 1.5 2.34 100 60 60 84 0   OK
OF-OK The pincer is open again, the closure has been completed.
F:___0N Force value for opening gap
S:10.99mm Opening gap 
_002 Ready for closure The ELK 02 is at the closure level and is waiting for a start from the user

Table 37 Data output at X3 at each completed step in step-by-step

Message text Meaning

Error 8 Error output here: Error 8 “APN not assigned”. 

Table 38 Data output at X3 on error
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Handshake at X3

Call up the individual measured data records:

Entry at X3 Call up from
GetH=? Holder measured data
GetD=? Detection measured data
GetK=? Contact measured data
GetS=? Closure function measured data
GetV=? Verification measured data

Table 39 Call up the individual measured data records

If no measured data are available for call off, the ELK 02 responds at X3:

• Priority: C

• Error number: 99

• Status: NO

Message text Meaning
Error 8 Error output here: Error 8 “APN not assigned”. 

Table 40 Data output at X3 on error

13.1.5 X20 interface

25-pin SUB-MIN-D (male)

INFO
The cable must be fitted with a ferrite ring at the cable end near the X20 interface.

Inputs

Opto-decoupled inputs, supplied by customer:

PIN 1   24 V = (19 - 30 V) (Customer voltage)

PIN 25   GND

Signal “0”  0…5 V

Signal “1”  15 - 30 V (> 100 ms for start)

Input current 10 mA (at 24 V)

Outputs

Opto-decoupled outputs, supplied by customer:

PIN 1   24 V = (19 - 30 V) (Customer voltage)

PIN 25  GND

Signal “0” 0 V

Signal “1” Customer voltage -0.5 V

Output current typically 20 mA, short-circuit proof

PIN Assignment PIN Assignment
1 +24 V (from customer to activate I/Os) 15* Bit 64 input
2* Reset input 16* Spare input
3* Enable input 17* Busy output
4* Function input 18* System error output
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PIN Assignment PIN Assignment
5* Start input 19* Pincer test output
6* Spare input 20* Ready output
7* Pincer test input 21* OK output
8* Spare input 22* NO output
9* Bit 1 input 23* Spare output
10* Bit 2 input 24* Spare output
11* Bit 4 input 25 GND (from customer to activate I/Os) 
12* Bit 8 input HOUSING PE (protective earth) conductor
13* Bit 16 input
14* Bit 32 input

Table 41 PIN assignment for X20 interface

*) Inputs and outputs opto-decoupled

Description of the PIN assignments for the X20 interface

PIN assignment Function Description Times
Reset Input Cancels a closure function that was started, cancels the pincer test

Error message F19 RESET CANCEL

Impulse 

> 300 ms
Enable Input The “Start” function is active only when “Enable” is activated continuous 

signal
Function Input Acknowledgment of routines in accordance with specifications or 

diagrams For the “Function” display

• Request pincer test

• Request APN

4 s

2 s

4 s
Start Input “Start” can initiated only if “Enable” is active > 100 ms
Pincer test Input Skip back to the “Function” display.

From here you can select

• Request pincer test

• Request APN 

2 s

4 s
Bit 1 to bit 64 Input APN selection

NOTICE: The sum of the bits determines the APN

 Example: APN 40: Bit 8 + 32

continuous 

signal

Busy Output Active on startup after ELK 02 is powered up
System error Output Active with error message F1 to F03, F08, F15, F16, F19 to F21, F23
Ready Output Active: “Close” is enabled

Table 42 Description of the PIN assignments for the X20 interface



OETIKER ELK 02 V2.X 13 Technical data

Issue 05.2021 08903352 13-127

Fig. 85 Connection diagram for the X20 interface

Output matrix

Function Busy System 

error

Pincer 

test

Ready OK NO

ELK 02 ON (OETIKER logo) Output test H H H H H H
ELK 02, firmware version, creation date H
Pincer test H
Error messages F1 to F03, F08, F15, F16, 

F19 to F21, F23

H

Ready (enable for closure) H
During closure H
Closure result OK H
Closure result NO H

Table 43 Output matrix
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13.1.6 USB interface

INFO
•  The cable must be fitted with a ferrite ring at the cable end near the USB socket.

•  The USB interface may only be used for data exchange with the PC, not for data outputs.

•  A driver must be loaded and installed on the PC before establishing a USB connection between the PC 

and the ELK 02 for the first time. This installation takes place automatically.

  If the automatic installation is unsuccessful, the driver is located in the installation directory of the PC and 

can be manually installed.

•  Once the USB connection has been plugged in, the ELK 02 PC program may need to be reopened in 

order to locate the driver.

13.2 Technical data

13.2.1 Fluidics

INFO
•  As the ELK 02 unit is used for control technology, absolute cleanliness must be ensured during assembly.

•  The pE and pA connections must always be closed off when not in use to prevent the penetration of dust.

•  The recommended filter must be installed in a vertical position ahead of the ELK 02 control unit.

•  An oil- and water-free air supply must be provided. 

•  For control technology reasons, in particular with long air supply ducts, we recommend installing an 

accumulator (volume 1 to 5 liters, depending on the pincer size) ahead of the ELK 02, directly on the 

compressed air supply pE. The applicable regulations must be observed.

•  Replacement filter – e.g. FESTO, series M (see maintenance instructions).

Fluidic inputs and outputs

NOTICE
Damage caused by broken pincer jaws

  When using the HO 10000 pincer model, make sure that the compressed air supply pE does not exceed 

5 bar.
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Compressed air supply pE > 4 bar... max. 10 bar

Recommended compressed air supply pE  > 6 bar... max. 10 bar

Air quality  < 5 μ, unoiled, dewatered (ISO 8573-1)

Air quantity  2 l/closure (HO 7000)

Connections for fluids

• Compressed air supply   Connector for 8/6 mm hose

• Compressed air outlet    Connector for 8/6 mm hose.

13.2.2 ELK 02 housing

External dimensions: 200 x 230 x 70 mm

Weight: 3.7 kg

Color: light gray, powder-coated.

13.2.3 Accuracy within the working temperature range

INFO
Prior to use, the ELK 02 should be switched on for approximately 1 hour for warm-up.

Closing force tolerances within the working temperature range

Force priority closure Gap priority closure
HO 2000 – HO 4000 ±150 N ±0.2 mm
HO 5000 ±250 N ±0.2 mm
HO 7000 ±250 N ±0.2 mm
HO 10000 ±300 N ±0.2 mm
CmK value ≥ 1.33

Table 44: Accuracy within the working temperature range

13.2.4 Temperature

Temperature in storage  0° C …+60° C

Working temperature  +15° C …+40° C
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14 Troubleshooting

14.1 General notes on faults

•  If the closure operation will not start or faults occur during operation, consult the maintenance personnel 

responsible for the ELK 02. 

•  Operators must inform their supervisor. Under no circumstances should you try to rectify faults on the 

ELK 02 yourself. If a fault occurs, please contact OETIKER (www.oetiker.com).

14.2 What to do, when...?

Type of fault Reason for fault Actions to rectify fault
Closure operation will not start Unit not switched on Switch on unit, execute pincer test
Unit switched on, no display Control unit fault Send to OETIKER
Loud noise of rushing air in the 

control unit 

Leaking valves Send to OETIKER

Display shows incoherent text Electromagnetic interference above 

permitted limit 

Reload all data

Table 44 Fault table

14.3 Error messages and error correction measures

Error Cause/Error correction Output X2 Output X20
F01 SUPPLY PRESSURE Increase supply pressure NO à H System error à H
F02 NO PINCER Close the pincer 

Measuring system defective

NO à H System error à H

F03 MEASURING 

SYSTEM

Tighten connector screws 

Pincer defective

NO à H System error à H

F04 OS - ERROR Modify OS and OS-T 

Recalibrate pincer 

Replace pincer

NO à H NO à H

F05 SK - ERROR Increase supply pressure 

Modify SK and SK-T 

Modify SK-HZ 

Recalibrate pincer 

Replace electronics

NO à H NO à H
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Error Cause/Error correction Output X2 Output X20
F06 SS - ERROR Modify SS and SS-T 

Modify SS-HZ 

Recalibrate pincer 

Replace electronics

NO à H NO à H

F07 SK + SS - ERROR Modify SK and SK-T 

Modify SS and SS-T 

Modify SK-HZ 

Modify SS-HZ 

Recalibrate pincer 

Replace electronics

NO à H NO à H

F08 APN DATA APN data missing

Selected APN invalid

NO à H System error à H

F09 HK - ERROR Modify HK and HK-T

Recalibrate pincer

Replace electronics

NO à H NO à H

F10 HS - ERROR Modify HS and HS-T

Clamp in the pincer?

Recalibrate pincer

Replace electronics

NO à H NO à H

F11 HK + HS - ERROR Modify HK and HK-T

Modify HS and HS-T

Clamp in the pincer?

Recalibrate pincer

Replace electronics

NO à H NO à H

F12 VK - ERROR Modify VK and VK-T

Modify VK-HZ

Recalibrate pincer

Replace electronics

NO à H NO à H

F13 VW - ERROR Modify VW and VW-T

Low Profile Clamp jammed

Recalibrate pincer

Replace electronics

NO à H NO à H
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Error Cause/Error correction Output X2 Output X20
F14 VK + VW - ERROR Modify VK and VK-T

Modify VK-HZ

Modify VW and VW-T

Low Profile Clamp jammed

Recalibrate pincer

Replace electronics

NO à H NO à H

F15 DATA STORE EMPTY Input pincer data

Load closure data

Load factory data

Replace electronics

NO à H System error à H

F16 CANCEL PROCESS Touch mode?

Incorrect/no measuring device

Replace pincer

Replace electronics

NO à H System error à H

F17 NOT ENGAGED Adjust closure data

Check clamp design

Unsuitable material being clamped

NO à H NO à H

F18 QUANTITY The pre-set number has been reached

A pincer test is required

NO à H NO à H

F19 RESET CANCEL Cancel via reset input NO à H System error à H
F20 OF - ERROR Pincer not open

Recalibrate pincer

Replace pincer

NO à H System error à H

F21 WN_TOO_HIGH In force calibration with constant nominal 

force the calculated target value is too high

Send pincer type data

NO à H System error à H

F22 DETECTION ERROR The same clamp has already been closed

No clamp present

NO à H NO à H

F23 LOSS OF PRESSURE Increase supply pressure

Clean pre-filter

Install accumulator

NO à H System error à H

F24 MAINTENANCE Send to OETIKER for servicing

Replace electronics

NO à H NO à H

F25 MAX. 20 CLOSURES Max. number of closures in pincer test mode 

exceeded

NO à H System error à H

Table 45 Error messages
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15 Checklists – repair forms

15.1 Checklist for ELK 02, control unit

Please fill out this form legibly in BLOCK CAPITALS. Thank you!

Place, date  ............................................................  Name: ........................................................................  

Telephone No.:  ............................................................  Fax: ............................................................................  

Type:  ............................................................  Serial no.: ...................................................................  

Delivery date:  ............................................................  Version V: ...................................................................  

Company name:  ............................................................   

Address:  ............................................................   

  ............................................................

  ............................................................

Department:  ............................................................  Production area: ........................................................   

Operating hours/day: .......................................................  Last pincer test: .........................................................  

Application:  O Single  O Close function

    O Sequential  O OPEN

    O Chaotic   O Hold; O Detect

      O Verify

Start:  O START button  O via PLC, type. .........................................................

    O externally at X2.  O In-house control

    O externally at X20

Description of fault

Failure:  O immediately  O after . . . . days  O after . . . . months
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Possible faults

Electrical:   O none shown in the display

    O Incorrect display / illogical display

    O Display error F....... occurred  

    O Panel-mounted connector defective (mechanical)

    O Threaded bolt for securing connector defective  

    O OK / NO output signal at X2/X20 not working

    O Inputs at X2/X20: cannot be activated  

    O Data transfer between PC and ELK 02 not working – check cable first!

    O Pincer only working intermittently (loose contact at X1, pincer connector)

Mechanical   O Loud exhaust noises in housing 

    O Loud exhaust noises at small muffler

    O Loud exhaust noises at large muffler

    O Screw connections loose

    O Pincer permanently open in OS

    O Pincer permanently closed in SS

   O Filter dirty 
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15.2 Pincer checklist repair form

Please fill out this form legibly in BLOCK CAPITALS. Thank you!

Place, date  ............................................................  Name: ........................................................................  

Telephone No.:  ............................................................  Fax: ............................................................................  

Type:  ............................................................  Serial no.: ...................................................................  

Delivery date:  ............................................................  Version V: ...................................................................  

Company name:  ............................................................   

Address:  ............................................................   

  ............................................................

  ............................................................

Department:  ............................................................  Production area: ........................................................   

Operating hours/day: .......................................................  Last pincer test: .........................................................  

Start:    O START button  

Pincer holder:  O Manual

    O Device

    O Robot or similar

Corrugated hose:  O Loose on ELK 02

    O Mounted as per instructions in instruction manual

Description of fault

Failure:  O immediately  O after . . . . days  O after . . . . months
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Possible faults

Electrical:   O Start button no longer works   O  ...............................................................................

    O LED display defective    O  ...............................................................................

    O Loose contact in electrical connection    O  ...............................................................................

Fluids:    O Continuous escape of air (leak) from cylindrical part

   O Continuous escape of air (leak) from measuring module

   O Loss of force

   O Correlation between pincer force and ELK 02 display is incorrect

   O  Correlation between pincer force during calibration (pincer test) and closing force during  

closure is incorrect

   O .......................................................................................................................................................

Start:    O Corrugated hose broken O Closing gap too large

    O Compressed air hose broken  O Opening gap too small

    O  “START” membrane broken O Pincer jaws defective

   O ............................................................. O ................................................................................
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16 Warranty conditions

16.1 Warranty period

Warranty period for pincer

• 24 months for manufacturing faults, excluding wear parts.

Warranty period for wear parts

• 6 months.

Wear parts

ELK 02   Valves.

Trigger unit EL  Corrugated hose with compressed air hose and cable

   Gap measuring system

   Sleeve and pushbuttons

Pincers   Seals, plunger, rollers, pincer jaws

16.2 Conditions

• The component must have been commissioned as described in the instruction manual. 

• The component must not have been opened up or tampered with. 

• The trigger unit EL must not have been detached from the pincer body.

16.3 Warranty claims

A defect or the absence of warranted properties, subject to the above conditions, constitutes grounds for a warranty 

claim.

Return

We recommend returning the components in their original packaging.

If that is not possible, the components should be packed in protective packaging. It is a condition of return that 

the fluid sealing plugs on the control unit and the compressed air hose on the trigger unit are attached. If the 

component is damaged due to inadequate packaging, the customer shall bear the costs, notwithstanding any 

justified warranty claims.

Claim report

The claim report (part of the instruction manual) must be completed and returned with the component.

If no claim report is provided, all components will have to be tested in full. These costs shall be borne by the 

customer, notwithstanding any justified warranty claims.
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16.4 Consequential damage

We accept no liability for consequential damage arising indirectly or directly from the installation of our components.

16.5 Costs

Where a warranty claim is justified, we will bear the costs subject to return in the correct manner and submission of 

a fully filled out claim report (section 15).

If there are no grounds for a claim, the customer will be billed for the costs incurred.
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17 Declaration of Conformity

EC Declaration of Conformity

• in accordance with the Machinery Directive (2006/42/EC)

• in accordance with the EMC Directive (2004/108/EC)

• in accordance with the Low Voltage Directive (2006/95/EC)

The products listed below comply with the provisions of the above-mentioned directives:

Product designation

Electronically controlled pneumatic pincer OETIKER ELK 02.

Series/Model

Control unit, item no.

136 00 289 (85 to 265 V / 47 to 63 Hz, V1.X)

Pincer with standard heads and add-on unit

Model HO 2000 EL (T) to HO 10000 EL (T).

The following harmonized standards apply

• EN ISO 12100

• EN 60204-1

• EN ISO 4414

• EN 61000-6-4: 2007 + A1: 2011

• EN 61000-6-2: 2005
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